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safety information

These warnings and precautions are included to prevent injury to you and others, and to prevent any potential damage to
your machine. Be sure to read and understand all of these instructions before using the machine.

Use common sense for operating any electrical appliance and whenever using your machine. Also, follow all warnings and
instructions marked on the machine and in the accompanying literature. After reading this section, keep it in a safe place
for future reference.

IMPORTANT SAFETY SYMBOLS

This section explains the meanings of all icons and signs in the user's guide. These safety symbols are in order, according to the degree of
danger.

Explanation of all icons and signs used in the user’s guide:

Warning

Hazards or unsafe practices that may result in severe personal injury or death.

Caution

Hazards or unsafe practices that may result in minor personal injury or property damage.

Do not attempt.

Do not disassemble.

Do not touch.

Unplug the power cord from the wall socket.

Make sure the machine is grounded to prevent electric shock.

Call the service center for help.
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Follow directions explicitly.

OPERATING ENVIRONMENT

A Warning

o
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Do not use if the power cord is damaged or if the
electrical outlet is not grounded.

» This could result in electric shock or fire.

Do not place anything on top of the machine (water,
small metal or heavy objects, candles, lit cigarettes,
etc.).

» This could result in electric shock or fire.
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Do not bend, or place heavy objects on the power
cord.

» Stepping on or allowing the power cord to be
crushed by a heavy object could result in electric
shock or fire.

Do not remove the plug by pulling on the cord; do not
handle the plug with wet hands.

» This could result in electric shock or fire.



If the machine gets overheated, it releases smoke,
makes strange noises, or generates an odd odor,
immediately turn off the power switch and unplug the
machine.

» This could result in electric shock or fire.

A Caution

During an electrical storm or for a period of
non-operation, remove the power plug from the
electrical outlet.

» This could result in electric shock or fire.

Be careful, the paper output area is hot.
» Burns could occur.

If the machine has been dropped, or if the cabinet appears
damaged, unplug the machine from all interface connections
and request assistance from qualified service personnel.

» Otherwise, this could result in electric shock or fire.

If the machine exhibits a sudden and distinct change in
performance, unplug the machine from all interface
connections and request assistance from qualified service
personnel.

» Otherwise, this could result in electric shock or fire.

OPERATING METHOD

A Caution

Do not forcefully pull the paper out during printing.
» It can cause damage to the machine.

Be careful not to put your hand between the machine
and paper tray.

» You may get injured.

® Do not block or push objects into the ventilation opening.

» This could result in elevated component temperatures which
can cause damage or fire.

Be care when replacing paper or removing jammed paper.
» New paper has sharp edges and can cause painful cuts.

©

©

Safety information_ 4

O

-
Em

If the plug does not easily enter the electrical outlet, do not
attempt to force it in.

» Call an electrician to change the electrical outlet, or this
could result in electric shock.

Do not allow pets to chew on the AC power, telephone or PC
interface cords.

» This could result in electric shock or fire and/or injury to your
pet.

If the machine does not operate properly after these
instructions have been followed, unplug the machine from all
interface connections and request assistance from qualified
service personnel.

» Otherwise, this could result in electric shock or fire.

When printing large quantities, the bottom part of the
paper output area may get hot. Do not allow children
to touch.

» Burns can occur.

When removing jammed paper, do not use tweezers
or sharp metal objects.

» It can damage the machine.

Do not allow too many papers to stack up in the paper output
tray.

» It can damage the machine.

This machine's power interception device is the power cord.

» To switch off the power supply, remove the power cord from
the electrical outlet.



INSTALLATION / MOVING

A Warning

Do not place the machine in an area with dust,
<> humidity or water leaks.

» This could result in electric shock or fire.

A Caution

Before moving the machine, turn the power off and
disconnect all cords.

Then lift the machine:

« If the machine weighs under 20 kg (44.09Ib), lift with
1 person.

« If the machine weighs 20 kg (44.09Ib) - 40kg
(88.18Ib), lift with 2 people.

« If the machine weighs more than 40 kg (88.18Ib), lift
with 4 or more people.

» The machine could fall, causing injury or machine damage.

@ Do not place the machine on an unstable surface.
» The machine could fall, causing injury or machine damage.

@ The machine should be connected to
the power level which is specified on the label.

» If you are unsure and want to check the power level you are
using, contact the electrical utility company.

(D Use only No.26 AWG? or larger, telephone line cord, if
necessary.

» Otherwise, it can cause damage to the machine.

a. AWG: American Wire Gauge

MAINTENANCE / CHECKING

A Caution

Unplug this product from the wall outlet before
cleaning the inside of the machine. Do not clean the
machine with benzene, paint thinner or alcohol; do
not spray water directly into the machine.

» This could result in electric shock or fire.
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Do not put a cover over the machine or place it in an airtight
location, such as a closet.

» If the machine is not well-ventilated, this could result in fire.

Make sure you plug the power cord into a grounded electrical
outlet.

» Otherwise, this could result in electric shock or fire.

Do not overload wall outlets and extension cords.

» This can diminish performance, and could result in electric
shock or fire.

Use the power cord supplied with your machine for safe
operation. If you are using a cord which is longer than 2 meters
(6 feet) with a 140V machine, then the gauge should be 16
AWG or larger.

» Otherwise, it can cause damage to the machine, and could
result in electric shock or fire.

Keep cleaning supplies away from children.
» Children could get hurt.



When you are working inside the machine replacing
supplies or cleaning the inside, do not operate the
machine.

» You could get injured.

@ Keep the power cable and the contact surface of the plug clean @

from dust or water.
» Otherwise, this could result in electric shock or fire.

® Do not remove any covers or guards that are fastened with

Screws.

» The machine should only be repaired by a Samsung service
technician.

SUPPLY USAGE

A Caution

® When changing the toner cartridge or removing jammed paper, @

be careful not to let toner dust touch your body or clothes.
» Toner dust can be dangerous if inhaled or ingested.
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®7 Do not disassemble the toner cartridge.
/ > Toner dust can be dangerous if inhaled or
—_— ingested.
®7 Do nlot burn any of the supplies such as toner ®
_ - cartridge or fuser unit.
é fi>reThis could cause an explosion or uncontrollable

Do not disassemble, repair or rebuild the machine by
yourself.

» It can damage the machine. Call a certified
technician when the machine needs repair.

To clean and operate the machine, strictly follow the user's
guide provided with the machine.

» Otherwise, you could damage the machine.

When storing supplies such as toner cartridges, keep
them away from children.

» Toner dust can be dangerous if inhaled or
ingested.

Using recycled supplies, such as toner, can cause damage to
the machine.

» In case of damage due to the use of recycled supplies, a
service fee will be charged.

When toner gets on your clothing, do not use hot water to wash
it.
» Hot water sets toner into fabric. Use cold water.



regulatory information

This machine is designed for a normal work environment and certified with several regulatory statements.

LASER SAFETY STATEMENT

The printer is certified in the U.S. to conform to the requirements of DHHS 21 CFR, chapter 1 Subchapter J for Class I(1) laser products, and
elsewhere is certified as a Class | laser product conforming to the requirements of IEC 60825-1:1993 + A1:1997 + A2:2001.

Class | laser products are not considered to be hazardous. The laser system and printer are designed so there is never any human access to
laser radiation above a Class | level during normal operation, user maintenance or prescribed service condition.

*  Wavelenght: 800 nm
* Beam divergence
- Paraller: 12 degrees
- Perpendicular: 30 degrees
* Maximum power or energy output: 5 mW

WARNING

Never operate or service the printer with the protective cover removed from Laser/Scanner assembly. The reflected beam, although invisible,
can damage your eyes.

When using this product, these basic safety precautions should always be followed to reduce risk of fire, electric shock, and injury to persons:

CAUTION - CLASS 38 LASER RADIATION WHEN OPEN
AVOID EXPOSURE TO THE BEAM
DANGER - LASER RADIATION AVOID DIRECT
EXPOSURE TO BEAM.
DANGER - RADIATIONS INVISIBLES DU LASER EN CAS
DOUVERTURE. EVITER TOUTE EXPOSITION
DIRECTE AU FAISCEAU.
VORSICHT - UNSICHTBARE LASERSTRAHLUNG, WENN
ABDECKUNG GEOFFNET.
NICHT DEM STRAHL AUSSETZEN.
ATTENZIONE - RADIAZIONE LASER INVISIBILE IN CASO DI
APERTURA. EVITARE L'ESPOSIZIONE AL FASCIO.
PRECAUCION - RADIACION LASER INVISIBLE CUANDO SE ABRE.
EVITAR EXPONERSE AL RAYO.
PERIGO - RADIAGAO LASER INVISIVEL AO ABRIR. EVITE
EXPOSICAO DIRECTAAO FEIXE
GEVAAR - ONZICHTBARE LASERSTRALEN BL GEOPENDE
KLEP. DEZE KLEP NIET OPENEN.
ADVARSEL - USYNLIG LASERSTRALNING VED ABNING.
UNDGA UDSAETTELSE FOR STRALNING.
ADVARSEL. - USYNLIG LASERSTRALNING NAR DEKSEL
APNES. UNNGA EKSPONERING FOR STRALEN.
VARNING - OSYNLIG LASERSTRALNING NAR DENNA DEL
AR OPPEN. STRALEN AR FARLIG.
VAROITUS - NAKYMATONTA LASERSATEILYA AVATTAESSA.
VARO SUORAA ALTISTUMISTA SATEELLE.
E R -TERBFLE MR RN
F 9 -0l YHE B Bo|xol| =FE o2
FolstAl,

OZONE SAFETY

During normal operation, this machine produces ozone. The ozone produced does not present a hazard to the operator. However, it is
advisable that the machine be operated in a well ventilated area.
If you need additional information about ozone, contact your local Samsung dealer.
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RECYCLING

@ Recycle or dispose of the packaging material for this product in an environmentally responsible manner.
CHINA ONLY
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CORRECT DISPOSAL OF THIS PRODUCT (WASTE ELECTRICAL & ELECTRONIC EQUIPMENT)

(Applicable in the European Union and other European countries with separate collection systems)

This marking shown on the product, accessories or literature indicates that the product and its electronic accessories (e.g. charger, headset,
USB cable) should not be disposed of with other household wastes at the end of its working life. To prevent possible harm to the environment
or human health from uncontrolled waste disposal, separate this from other types of wastes and recycle it responsibly to promote the
sustainable reuse of material resources.

] Household users should contact either the retailer where they purchased this product, or their local government office, for details of where and
how they can take this item for environmentally safe recycling.
Business users should contact their supplier and check the terms and conditions of the purchase contract. This product should not be mixed
with other commercial wastes for disposal.

RADIO FREQUENCY EMISSIONS

FCC Information to the User

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:

« This device may not cause harmful interference, and

» This device must accept any interference received, including interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These

limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses

and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to

radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause

harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to

try to correct the interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

* Consult the dealer or experienced radio TV technician for help.

'g Change or modifications not expressly approved by the manufacturer responsible for compliance could void the user's authority to
operate the equipment.
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Canadian Radio Interference Regulations
This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus as set out in the interference-causing
equipment standard entitled “Digital Apparatus”, ICES-003 of the Industry and Science Canada.

Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils numériques de Classe B prescrites dans la
norme sur le matériel brouilleur: “Appareils Numériques”, ICES-003 édictée par I'Industrie et Sciences Canada.

UNITED STATES OF AMERICA

Federal Communications Commission (FCC)

Intentional emitter per FCC Part 15

Low power, Radio LAN type devices (radio frequency (RF) wireless communication devices), operating in the 2.4 GHz/5 GHz Band, may be
present (embedded) in your printer system. This section is only applicable if these devices are present. Refer to the system label to verify the
presence of wireless devices.

Wireless devices that may be in your system are only qualified for use in the United States of America if an FCC ID number is on the system
label.

The FCC has set a general guideline of 20 cm (8 inches) separation between the device and the body, for use of a wireless device near the
body (this does not include extremities). This device should be used more than 20 cm (8 inches) from the body when wireless devices are on.
The power output of the wireless device (or devices), which may be embedded in your printer, is well below the RF exposure limits as set by
the FCC.

This transmitter must not be collocated or operation in conjunction with any other antenna or transmitter.

Operation of this device is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must
accept any interference received, including interference that may cause undesired operation of the device.

Wireless devices are not user serviceable. Do not modify them in any way. Modification to a wireless device will void the authorization to
use it. Contact manufacturer for service.

FCC Statement for Wireless LAN use:

A While installing and operating this transmitter and antenna combination the radio frequency exposure limit of 1m W/cm2 may be
exceeded at distances close to the antenna installed. Therefore, the user must maintain a minimum distance of 20cm from the antenna at
all times. This device cannot be colocated with another transmitter and transmitting antenna.

TURKEY ONLY

* RoHS

EEE Yd&netmeligine Uygundur.
This EEE is compliant with RoHS.
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REPLACING THE FITTED PLUG (FOR UK ONLY)

Important

The mains lead for this machine is fitted with a standard (BS 1363) 13 amp plug and has a 13 amp fuse. When you change or examine the
fuse, you must re-fit the correct 13 amp fuse. You then need to replace the fuse cover. If you have lost the fuse cover, do not use the plug until
you have another fuse cover.

Contact the people from you purchased the machine.

The 13 amp plug is the most widely used type in the UK and should be suitable. However, some buildings (mainly old ones) do not have normal
13 amp plug sockets. You need to buy a suitable plug adaptor. Do not remove the moulded plug.

A If you cut off the moulded plug, get rid of it straight away.

You cannot rewire the plug and you may receive an electric shock if you plug it into a socket.

Important warning:

You must earth this machine.

The wires in the mains lead have the following color code:
* Green and Yellow: Earth

* Blue: Neutral

* Brown: Live

If the wires in the mains lead do not match the colors marked in your plug, do the following:

You must connect the green and yellow wire to the pin marked by the letter “E” or by the safety ‘Earth symbol’ or colored green and yellow or
green.

You must connect the blue wire to the pin which is marked with the letter “N” or colored black.
You must connect the brown wire to the pin which is marked with the letter “L” or colored red.
You must have a 13 amp fuse in the plug, adaptor, or at the distribution board.

DECLARATION OF CONFORMITY (EUROPEAN COUNTRIES)

3

Approvals and Certifications

The CE marking applied to this product symbolizes Samsung Electronics Co., Ltd. Declaration of Conformity with the following applicable
93/68/EEC Directives of the European Union as of the dates indicated:

CLP-320 Series: Low Voltage Directive (2006/95/EC), EMC Directive (2004/108/EC)
CLP-325W(K): R&TTE Directive (1999/5/EC)

The declaration of conformity may be consulted at www.samsung.com/printer, go to Support > Download center and enter your printer (MFP)
name to browse the EuDoC.

January 1, 1995: Council Directive 2006/95/EC Approximation of the laws of the member states related to low voltage equipment.

January 1, 1996: Council Directive 2004/108/EC (92/31/EEC), approximation of the laws of the Member States related to electromagnetic
compatibility.

March 9, 1999: Council Directive 1999/5/EC on radio equipment and telecommunications terminal equipment and the mutual recognition of
their conformity. A full declaration, defining the relevant Directives and referenced standards can be obtained from your Samsung Electronics
Co., Ltd. representative.
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EC Certification
Certification to 1999/5/EC Radio Equipment & Telecommunications Terminal Equipment Directive (FAX)

This Samsung product has been self-certified by Samsung for pan-European single terminal connection to the analogue public switched
telephone network (PSTN) in accordance with Directive 1999/5/EC. The product has been designed to work with the national PSTNs and
compatible PBXs of the European countries:

In the event of problems, you should contact the Euro QA Lab of Samsung Electronics Co., Ltd. in the first instance.

The product has been tested against TBR21. To assist in the use and application of terminal equipment which complies with this standard, the
European Telecommunication Standards Institute (ETSI) has issued an advisory document (EG 201 121) which contains notes and additional
requirements to ensure network compatibility of TBR21 terminals. The product has been designed against, and is fully compliant with, all of the
relevant advisory notes contained in this document.

European Radio Approval Information (for products fitted with EU-approved radio devices)

Low power, Radio LAN type devices (radio frequency (RF) wireless communication devices), operating in the 2.4 GHz/5 GHz band, may be
present (embedded) in your printer system which is intended for home or office use. This section is only applicable if these devices are present.
Refer to the system label to verify the presence of wireless devices.

Wireless devices that may be in your system are only qualified for use in the European Union or associated areas if a CE mark
with C € a Notified Body Registration Number and the Alert Symbol is on the system label.

The power output of the wireless device or devices that may be embedded in you printer is well below the RF exposure limits as set by the
European Commission through the R&TTE directive.

European States qualified under wireless approvals:

EU

Austria, Belgium, Cyprus, Czech Republic, Denmark, Estonia, Finland, France (with frequency restrictions), Germany, Greece, Hungary,
Ireland, Italy, Latvia, Lithuania, Luxembourg, Malta, The Netherlands, Poland, Portugal, Slovakia, Slovenia, Spain, Sweden and the U.K.
EEA/EFTA countries

Iceland, Liechtenstein, Norway and Switzerland

European States with restrictions on use:

EU

In France, the frequency range is restricted to 2446.5-2483.5 MHz for devices above 10 mW transmitting power such as wireless
EEA/EFTA countries

No limitations at this time
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REGULATORY COMPLIANCE STATEMENTS

Wireless Guidance

Low power, Radio LAN type devices (radio frequency (RF) wireless communication devices), operating in the 2.4 GHz/5 GHz Band, may be
present (embedded) in your printer system. The following section is a general overview of considerations while operating a wireless device.
Additional limitations, cautions, and concerns for specific countries are listed in the specific country sections (or country group sections). The
wireless devices in your system are only qualified for use in the countries identified by the Radio Approval Marks on the system rating label. If
the country you will be using the wireless device in, is not listed, contact your local Radio Approval agency for requirements. Wireless devices
are closely regulated and use may not be allowed.

The power output of the wireless device or devices that may be embedded in your printer is well below the RF exposure limits as known at this
time. Because the wireless devices (which may be embedded into your printer) emit less energy than is allowed in radio frequency safety
standards and recommendations, manufacturer believes these devices are safe for use. Regardless of the power levels, care should be taken
to minimize human contact during normal operation.

As a general guideline, a separation of 20 cm (8 inches) between the wireless device and the body, for use of a wireless device near the body
(this does not include extremities) is typical. This device should be used more than 20 cm (8 inches) from the body when wireless devices are
on and transmitting.

This transmitter must not be collocated or operation in conjunction with any other antenna or transmitter.

Some circumstances require restrictions on wireless devices. Examples of common restrictions are listed below:

A Radio frequency wireless communication can interfere with equipment on commercial aircraft. Current aviation regulations require wireless
devices to be turned off while traveling in an airplane. IEEE 802.11 (also known as wireless Ethernet) and Bluetooth communication devices
are examples of devices that provide wireless communication.

A In environments where the risk of interference to other devices or services is harmful or perceived as harmful, the option to use a wireless
device may be restricted or eliminated. Airports, Hospitals, and Oxygen or flammable gas laden atmospheres are limited examples where use
of wireless devices may be restricted or eliminated. When in environments where you are uncertain of the sanction to use wireless devices, ask
the applicable authority for authorization prior to use or turning on the wireless device.

A Every country has different restrictions on the use of wireless devices. Since your system is equipped with a wireless device, when traveling
between countries with your system, check with the local Radio Approval authorities prior to any move or trip for any restrictions on the use of
a wireless device in the destination country.

A If your system came equipped with an internal embedded wireless device, do not operate the wireless device unless all covers and shields are
in place and the system is fully assembled.

A Wireless devices are not user serviceable. Do not modify them in any way. Modification to a wireless device will void the authorization to use
it. Contact manufacturer for service.

A Only use drivers approved for the country in which the device will be used. See the manufacturer System Restoration Kit, or contact
manufacturer Technical Support for additional information.

OPENSSL LICENSE

Copyright (c) 1998-2001 The OpenSSL Project. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following acknowledgment: "This product includes
software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)".

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived from this software without
Prior written permission. For written permission, please contact openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without prior written
permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment: "This product includes software developed by the
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OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)".
THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product includes software written by Tim
Hudson (tjih@cryptsoft.com).

ORIGINAL SSLEAY LICENSE

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The implementation was written so as to conform with

Netscapes SSL.

This library is free for commercial and non-commercial use as long as the following conditions are adhered to. The following conditions apply to

all code found in this distribution, be it the RC4, RSA, lhash, DES, etc., code; not just the SSL code. The SSL documentation included with this

distribution is covered by the same copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com). Copyright remains Eric Young's,
and as such any Copyright notices in the code are not to be removed. If this package is used in a product, Eric Young should be given
attribution as the author of the parts of the library used. This can be in the form of a textual message at program startup or in documentation

(online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following acknowledgement: "This product includes
cryptographic software written by Eric Young (eay@cryptsoft.com)" The word 'cryptographic’ can be left out if the routines from the library
being used are not cryptographic related.

4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) you must include an
acknowledgement: "This product includes software written by Tim Hudson (tjh@cryptsoft.com)".

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT

LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN

NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY,

OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,

WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF

THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The licence and distribution terms for any publicly available version or derivative of this code cannot be changed. i.e. this code cannot simply

be copied and put under another distribution licence [including the GNU Public Licence.
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aoout this user's guide

This user’s guide provides information about basic understanding of the machine as well as detailed explanation on each
step during actual usage. It is a valuable resource for both novice and professional users for the proper installation and
use of the machine.

',g * Read the safety information before using the machine.
+ If you have a problem using the machine, refer to the troubleshooting chapter (See "Troubleshooting" on page 72).
+ Terms used in this user’s guide are explained in the glossary chapter (See "Glossary" on page 92).
+ lllustrations in this user’s guide may differ from your machine depending on its options or models.
* The procedures in this user’s guide are mainly based on Windows XP.

CONVENTION

Some terms in this guide are used interchangeably as below.
« Document is synonymous with original.

« Paper is synonymous with media or print media.

* Machine refers to printer or MFP.

The following table offers the conventions of this guide.

CONVENTION DESCRIPTION EXAMPLE
Bold For texts on the display or button names on the machine. Cancel
Note Provides additional information or details for the machine function and feature. [»ﬁ The date format may differ from country

to country.

Caution Contains information you can use to protect the machine from possible E)gaqgtjti% ut?]r:sttr:)?]::}g:r?rei dOfeﬂ;? i?r::min
mechanical damage or malfunction. unit 9 ging

Footnote Provides additional information on certain words or a phrase. a. pages per minute

(“Cross-reference”) Refers you to additional detailed information. (See "Finding more information" on page 16)

About this user’s guide_ 15



FINDING MORE INFORMATION

You can find information about setting up and using your machine in the following resources, either as a print-out or on screen.

MATERIAL NAME

DESCRIPTION

Quick Installation
Guide

This guide provides information on setting up your machine. This guide is provided in the box with the printer.

User’s Guide

/)

This guide provides you with step-by-step instructions for using your machine’s full features, maintaining your machine,
troubleshooting, and replacing supplies.

Machine Driver Help

This help provides you with help information about the printer driver and instructions for setting up the options for printing (See "Using
help" on page 58).

Samsung website

If you have Internet access, you can get help, support, machine drivers, manuals and order information from the Samsung website,
www.samsung.com/printer.

Downloadable
software

You can download useful software programs from the Samsung website.

» Samsung AnyWeb Print: helps personal users to screen-capture the website screen in Windows Internet Explorer easily.
(http://solution.samsungprinter.com/personal/anywebprint)

* Samsung Easy Color Manager: helps Samsung color laser printer users to adjust color as they like.
(http://solution.samsungprinter.com/personal/colormanager)

About this user’s guide_ 16



features of your new product

Your new machine is equipped with a number of special features that improve the quality of the documents you print.

SPECIAL FEATURES

DPI

Print with excellent quality and speed

You can print in a full range of colors using cyan, magenta,
yellow and black.

You can print with a resolution of up to 2400 x 600 dpi
effective output.

Your machine prints A4-sized paper at up to 16 ppm and
Letter-sized paper at up to 17 ppm in black and white mode
and 4 ppm in color mode.

Handle many different types of printable material

|

Create professional documents (Windows only)

=

S

v

The tray holds up to 150 sheet of plain paper in various
sizes.

You can load different custom-size print media in the tray.

Print Watermarks. You can customize your documents with
words such as “Confidential” (See "Using watermarks" on
page 59).

Print Posters. The text and pictures of each page of your
document are magnified and printed across the sheet of
paper and can then be taped together to form a poster (See
"Printing posters" on page 58).

You can use preprinted forms and letterhead with plain
paper (See "Using overlay" on page 60).

Save time and money

To save paper, you can print multiple pages on one single
sheet of paper (See "Printing multiple pages on one sheet of
paper" on page 58).

This machine automatically conserves electricity by
substantially reducing power consumption when not in use.
To save paper, you can print on both sides of the paper
(Manual) (See "Printing on both sides of the paper (Manual)"
on page 59).

Features of your new product_ 17

Print in various environments

You can print with Windows as well as Linux and Macintosh
OS systems.

Your machine is equipped with a Hi-Speed USB 2.0
interface.

Your machine comes with a built-in network interface,
Ethernet 10/100 BaseTX.
(CLP-320N(K)/CLP-321N/CLP-325W(K) only)

Your machine comes with a built-in network Interface 802.11
b/g/n wireless LAN. (CLP-325W(K) only)

IPv6 (CLP-320N(K)/CLP-321N/CLP-325W(K) only)

The machine supports IPv6 (See "IPv6 configuration" on
page 32).

DLNA

This Machine supports DLNA Printing as a DMPr (Digital Media
Printer). You can easily print by the DLNA Device including
Printing Control Capability on the home network.



FEATURES BY MODELS

The machines are designed to support all of your document needs from printing to more advanced networking solutions for your business.

Features by models include:

FEATURES

CLP-320(K)
CLP-321
CLP-325(K)
CLP-326

CLP-320N(K)
CLP-321N

CLP-325W(K)

Hi-Speed USB 2.0

Network Interface Ethernet 10/100 BaseTX wired LAN

Network Interface 802.11 b/g/n wireless LAN?®

Duplex (2-sided) printing (Manual)

a.Depending on your country, wireless LAN cards may not be available. Contact your local Samsung dealer or the retailer where

you bought your printer.

( ®: Included, Blank: Not available)
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Ntroduction

This chapter gives you an overview of your machine.

This chapter includes:
* Machine overview * Understanding the control panel
« Control panel overview

MACHINE OVERVIEW

Front view

This illustration may differ from your machine depending on its model.

Output tray (face down) Front cover

QOutput support Front cover release button

Top cover Toner cartridges

Control panel Waster toner container

WO LWEE
EO®EE

Tray Imaging unit
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Rear view

This illustration may differ from your machine depending on its model.

@ Rear cover release button @ USB port
@ Rear cover @ Network port?

Power receptacle

a.CLP-320N(K)/CLP-321N only.
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CONTROL PANEL OVERVIEW

This illustration may differ from your machine depending on its model.

T

I A

.

S oo

[1] CLP-320(K)/CLP-321/CLP-325(K)/ CLP-326/CLP-320N(K)/CLP-321N

@ Toner colors

Shows the status of each toner cartridge (See "Status/ Toner colors LEDs" on page 22).

@ Power

You can turn the power on and off with this button (See "Power button" on page 23).

@ Cancel

Stops an operation at any time and there are more functions (See "Cancel button" on page 23).

@ Status LED

Shows the status of your machine (See "Status/ Toner colors LEDs" on page 22).

Print Screen?®

Prints the displayed screen of your monitor (See "Print screen button" on page 23).

Demo Print®

Prints a demo page (See "Demo print button" on page 23).

a.CLP-320(K)/CLP-321/CLP-325(K)/ CLP-326 only.

b.CLP-320N(K)/CLP-321N only.

[2] CLP-325W(K)

@ Toner colors Shows the status of each toner cartridge (See "Status/ Toner colors LEDs" on page 22).
@ Power You can turn the power on and off with this button (See "Power button" on page 23).
Cancel Stops an operation at any time and there are more functions (See "Cancel button" on page 23).
@ Status LED Shows the status of your machine (See "Status/ Toner colors LEDs" on page 22).
Wireless Shows the status of wireless network. When the LED on, the machine is connected wirelessly (See "Wireless LED"
@ on page 22).
WPS If your wireless access point supports WPS (Wi-Fi Protected Setup™), you can configure the wireless network
@ connection easily without a computer (See "Using a wireless network with WPS button on the control panel” on
page 36).
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UNDERSTANDING THE CONTROL PANEL

Status/ Toner colors LEDs
The color of the LEDs indicates the machine's current status.

LED

STATUS

TONER
COLORS
LED

DESCRIPTION

Blinks red

Correspondi
ng LED is
solid red

* A minor error has occurred and
the machine is waiting for the
error to be cleared. When the

TONER
LED STATUS COLORS DESCRIPTION
LED
Online/E | Off All LEDs off | The machine is off-line.
rror Solid green | All LEDs off | The machine is on-line and can
(¢->/A) receive data from a computer.
Slowly All LEDs off | When the Status LED blinks
blinking green slowly, the machine is
green receiving data from a computer.
Quickly All LEDs off | When the Status LED blinks
blinking green quickly, the machine is
green printing data.
Solid green | Correspondi | Each toner cartridge is near the
ng LED end of its life.
blinks red
Correspondi | The machine is warming up.
ng LED
blinks red
successivel
y
Solid red All LEDs off |« The cover is open. Close the
cover.

« There is no paper in the tray.
Load paper in the tray.

* The machine has stopped due
to a major error.

« The machine is experiencing
system problems requiring
service, such as LSU error,
fuser error, or ITB error.
Contact the service
representative.

Correspondi |* A toner cartridge has almost
ng LED is reached its estimated cartridge
solid red life?. It is recommended to

replace the toner cartridge
(See "Replacing the toner
cartridge" on page 84).

« The machine cannot recognize
the status of toner cartriges
and the supplies information.
Open and close the cover and
check if the machie can
operate properly. If the problem
persists, turn the power off and
on.

problem is cleared, the
machine resumes.

* A small amount of toner is left
in the cartridge. The estimated
cartridge life? of toner is close.
Prepare a new cartridge for
replacement. You may
temporarily increase the
printing quality by redistributing
the toner in the cartridge
(See "Redistributing toner" on
page 72).

Jam

(8M)

Lights
orange

All LEDs off

A paper jam has occurred (See
"Clearing paper jams" on
page 73).

a.Estimated cartridge life means the expected or estimated toner cartridge
life, which indicates the average capacity of print-outs and is designed
pursuant to ISO/IEC 19798. The number of pages may be affected by
operating environment, printing interval, graphics, media type and media
size. Some amount of toner may remain in the cartridge even when red
LED is on and the printer stops printing.

A Samsung does not recommend using non-genuine Samsung toner

cartridge such as one that is refilled or remanufactured. Samsung
cannot guarantee a non-genuine Samsung toner cartridge's quality.
Service or repair required as a result of using non-genuine Samsung
toner cartridges will not be covered under the machine warranty.

'g All printing errors will be appear in the Smart Panel program window. If
the problem persists, call for service (See "Using the Smart Panel

program" on page 66).

Wireless LED

WIRELESS LED STATUS

DESCRIPTION

Blue Off ()

Wireless network is disconnected.

On ()

Wireless network is connected.

Slowly blinks
(=)

The machine starts connecting to a
wireless network.

Quickly blinks
(=)

The machine is connecting to
access point (or wireless router).
*  Wireless network connection is
being disconnected.

INTRODUCING THE USEFUL BUTTONS

Print screen button

[+ [ (cLP-320(K)/CLP-321/CLP-325(K)/ CLP-326 only)
By pressing the ®-[ (Print screen button), you can do the following

functions.
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FUNCTION DESCRIPTION

Printing the active Press this button and the green LED will start
window blinking. When the green LED stops blinking,
release the button.

Printing the whole
monitor screen

Press this button and the green LED will start
blinking. Release the button while it's blinking.

',g * The page will be printed on the default page like A4 or Letter.
* You can only use this function with a USB-connected machine.
* Print screen can only be used with Windows and Macintosh
operating systems.
* You can use this function only when the Smart Panel program is
installed.

Demo print button

Jidy (CLP-320N(K)/CLP-321N only)

It prints a demo page by pressing this button only. The printed page shows
the color print quality potential and overall print characteristics of the
machine.

Cancel button

By pressing the & (Cancel button), you can do the following functions.

FUNCTION DESCRIPTION

Printing demo page In ready mode, press and hold this button for
about 2 seconds until the status LED blinks
slowly, and release (See "Printing a demo

page" on page 24).

Printing configuration In ready mode, press and hold this button for
sheets about 5 seconds until the status LED blinks
quickly, and release (See "Printing a machine
report" on page 69).

Canceling print job Press @) (cancel button) during printing. The
red LED blinks while the print job is cleared

from both the machine and the computer and
then the machine returns to ready mode. This
may take some time depending on the size of

the print job.

WPS button

N
@ (CLP-325W(K) only)

This feature automatically detects which WPS (Wi-Fi Protected Setup™)
mode your access point uses. By pushing a button on the wireless LAN
router / access point and the machine, you can setup the wireless network
and security settings (See "Using a wireless network with WPS button on
the control panel” on page 36).

Power button

©

This button must be used to turn the machine on/off.
Turning on the machine
1. Plug in the power cord.
2. Press @ (Power button) on the control panel.

'g If you want to turn the power off, press and hold this button for
about 3 seconds.
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getting startec

This chapter gives you step-by-step instructions for setting up the USB connected machine and software.

This chapter includes:

« Setting up the hardware
« Printing a demo page
« Supplied software

SETTING UP THE HARDWARE

This section shows the steps to set up the hardware as is explained in the
Quick Installation Guide. Make sure you read the Quick Installation Guide
first and follow the steps below.

Location

1. Select a stable location.
Select a level, stable place with adequate space for air circulation. Allow
extra space to open cover(s) and tray(s).
The area should be well ventilated and away from direct sunlight or
sources of heat, cold and humidity. Do not set the machine close to the
edge of your desk or table.

|_ """"""""""""""""" -/
100 mm
(3.91in.)
e )
100 mm 100 mm
(3.9in.) (3.9in.)
- -

482.6 mm
(18.8in.)

Printing is suitable for altitudes under 1,000 m (3,281 ft). Refer to the
altitude setting to optimize your printing (See "Altitude adjustment" on
page 46).

Place the machine on a flat, stable surface so that there is no incline
greater than 2 mm (0.08 inch). Otherwise, printing quality may be

* System requirements
» Installing USB connected machine’s driver
« Sharing your machine locally

affected.

T me—aJ

2 - —.. 2
(éT‘o“&an)r et _f((TOnB‘in)

Unpack the machine and check all the enclosed items.

Remove tape holding the machine securely.

Load paper (See "Loading paper in the tray" on page 50).

Make sure that all cables are connected to the machine.

Turn the machine on (See "Turning on the machine" on page 23).

0 This machine will not operate when the power main fails.

I

PRINTING A DEMO PAGE

Print a demo page to make sure that the machine is operating correctly.
To print a demo page

In ready mode, press and hold the Cancel button for 2 seconds, then
release.

Also, you can use the & Demo page button for printing a demo page.
This button is supported on CLP-320N(K)/CLP-321N only.

SUPPLIED SOFTWARE

After you have set up your machine and connected it to your computer, you
must install the printer software. If you are a Windows or Macintosh OS
user, install the software from the supplied CD. If you are a Linux OS user,
download the software from the Samsung website
(www.samsung.com/printer) and install.

',g Machine software is occasionally updated for reasons like the release
of new operating system and etc. If needed, download the latest
version from the Samsung website. (www.samsung.com/printer)
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(O] CONTENTS

Printer driver: Use this driver to take full advantage of

your machine’s features.

* Smart Panel: This program allows you to monitor the
machine’s status and alerts you when an error occurs
during printing.

* Printer Settings Utility: This program allows you to set
up printer’s other options from your computer.

» SetIP: Use this program to set your machine’s TCP/IP

addresses. (CLP-320N(K)/CLP-321N/CLP-325W(K)

only)

Windows

Macintosh Printer Driver: Use this driver to take full advantage of

your machine’s features.

* Smart Panel: This program allows you to monitor the
machine’s status and alerts you when an error occurs
during printing.

» Printer Settings Utility: This program allows you to set
up printer’s other options from your computer.

+ SetlP: Use this program to set your machine’s TCP/IP
addresses. (CLP-320N(K)/CLP-321N/CLP-325W(K)
only)

Unified Linux Driver: Use this driver to take full

advantage of your machine’s features.

* Smart Panel: This program allows you to monitor the
machine’s status and alerts you when an error occurs
during printing.

* Printer Settings Utility: This program allows you to set
up printer’s other options from your computer.

» SetIP: Use this program to set your machine’s TCP/IP

addresses. (CLP-320N(K)/CLP-321N/CLP-325W(K)

only)

Linux .

SYSTEM REQUIREMENTS

Before you begin, ensure that your system meets the following
requirements:

Microsoft® Windows®

Your machine supports the following Windows operating systems.

REQUIREMENT (RECOMMENDED)

Windows operating systems.
« Administrator rights are required to install the software.

OPERATING
SYSTEM FREE HDD
CPU RAM SPACE
Windows Intel® Pentium® IV 3 GHz | 512 MB 15 GB
Vista® (1024 MB)
Windows® 7 Intel® Pentium® IV 1 GHz | 1 GB (2 16 GB
32-bit or 64-bit processor | GB)
or higher
«  Support for DirectX® 9 graphics with 128 MB memory
(to enable the Aero theme).
« DVD-R/W Drive
Windows Intel® Pentium® IV 1 GHz | 512 MB 10 GB
Server® 2008 (x86) or 1.4 GHz (x64) (2048 MB)
R2 processors (2 GHz or
faster)
'g * Internet Explorer® 5.0 or higher is the minimum requirement for all

* Windows Terminal Services is compatible with this machine.

Macintosh
REQUIREMENTS (RECOMMENDED)
OPERATING
SYSTEM FREE HDD
CPU RAM SPACE
Mac OS X10.3~ |+ Intel® < 128 MB for a 1GB
10.4 Processors PowerPC based
+  PowerPC G4/ Mac (512 MB)
G5 < 512 MB fora
Intel-based Mac
(1 GB)
Mac OS X10.5 |+« Intel® 512 MB (1 GB) 1GB
Processors
*« 867 MHz or
faster Power
PC G4/ G5
Mac OS X10.6 |+ |Intel® 1GB (2 GB) 1GB
Processors

REQUIREMENT (RECOMMENDED)
OPERATING
SYSTEM FREE HDD
CPU RAM SPACE
Windows® 2000 | Intel® Pentium® Il 400 64 MB 600 MB
MHz (Pentium IIl 933 (128 MB)
MHz)
Windows® XP Intel® Pentium® 111 933 128 MB 1.5 GB
MHz (Pentium IV 1 GHz) | (256 MB)
Windows Intel® Pentium® 111 933 128 MB 1.25 GB to
Server® 2003 MHz (Pentium IV 1 GHz) | (512 MB) 2GB
Windows Intel® Pentium® IV 1 GHz | 512 MB 10 GB
Server® 2008 | (Pentium IV 2 GHz) (2048 MB)
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Linux

ITEM REQUIREMENT (RECOMMENDED)
Operating RedHat® Enterprise Linux WS 4, 5 (32/64 bit)
system Fedora Core 2~10 (32/64 bit)

SuSE Linux 9.1 (32 bit)

OpenSuSE® 9.2, 9.3, 10.0, 10.1, 10.2, 10.3, 11.0,
11.1 (32/64 bit)

Mandrake 10.0, 10.1 (32/64 bit)

Mandriva 2005, 2006, 2007, 2008, 2009 (32/64 bit)
Ubuntu 6.06, 6.10, 7.04, 7.10, 8.04, 8.10 (32/64 bit)
SuSE Linux Enterprise Desktop 9, 10 (32/64 bit)
Debian 3.1, 4.0, 5.0 (32/64 bit)

CPU Pentium® IV 2.4 GHz (Intel Core™2)

RAM 512 MB (1024 MB)

Free HDD space 1 GB (2 GB)

INSTALLING USB CONNECTED MACHINE’S
DRIVER

A locally connected machine is a machine directly connected to your
computer by a USB cable. If your machine is attached to a network, skip the
following steps below and go on to installing network connected machine’s
driver (See "Installing network connected machine’s driver" on page 33).

',g Only use a USB cable no longer than 3 m (10 ft.).

Windows
You can install the machine software using the typical or custom method.
The following steps below are recommended for most users who use a

machine directly connected to your computer. All components necessary for

machine operations will be installed.

1. Make sure that the machine is connected to the computer and powered
on.

'g If the “Found New Hardware Wizard” window appears during the
installation procedure, click Cancel in close the window.

2. Insert the supplied software CD into your CD-ROM drive.

» The software CD should automatically run and an installation window

will appear.

» If the installation window does not appear, click Start and then Run.
Type X:\Setup.exe, replacing “X” with the letter which represents
your CD-ROM drive. Click OK.

* If you use Windows Vista, Windows 7 or Windows Server 2008 R2
click Start > All programs > Accessories > Run.

Type X:\Setup.exe replacing “X” with the letter which represents
your CD-ROM drive and click OK.

+ If the AutoPlay window appears in Windows Vista, Windows 7 or
Windows Server 2008 R2, click Run Setup.exe in Install or run
program field, and click Continue or Yes in the User Account
Control window.

. Select Install now.

) B
Pinsuug

’:9 Install Now &

{ View User's Guide j»

) Wireless Setting and Installation J-
P

& stvercesinstaion

Instaletion Lengusge: | englen ¥

If necessary, select a language from the drop-down list.

"Q * For CLP-325W(K) installation window, you can access
Wireless Setting and Installation menu. The Wireless
Setting and Installation allows you to install a wireless
network to connect to the machine with USB cable (See
"Setting a wireless network with USB cable" on page 38).

* The Advanced Installation has two options, Custom
Installation and Install Software Only. The Custom
Installation allows you to select the machine’s connection and
choose individual component to install. The Install Software
Only allows you to install the supplied software such as Smart
Panel. Follow the guide in the window.

. Read License Agreement, and select | accept the terms of the

License Agreement. Then, click Next.

BIX
License Agreement
Flnsse read the Licarse Agnemere.
Ucerne Langusoe! | trcheh. v
[END USER LICENSE AGREEMENT FOR SAMSUNG ELECTROMCS SOFTWARE &
PRODUCT

|
IMPORTANT-READ CAREFULLY: Thes Samaung Electionscs End-User Liconte Agrasmant
(EULA") in # legal agreemant between you (sither an indeadual or 8 single entity) sod

LOMOOneets, MeSs, prrted Matensls and “0nkne” or elCIIONK GoCUMANEMOn developed
and proaded by SAMSUNG ELECTRONICS ("SOFTWARE PRODUCT) For all other thisd
party software products which may be supplied with cr for the SAMSUNG devices, your use
«f such software products shall be subject to separate terms of use and end user bcense
|agreemaents of such third paies. Dy mstaling, copying, downloadng or using the
SOFTWARE PROGAUCT, you agree 10 be bound by the tems of this ELLA. ¥ you d not
w704 19 the terms of this EULA, you may not mstal or wse the SOFTWARE PRODUCT

[r GRAMT OF LICENSE.
[The SOFTWARE PRODUCT is Bcanted, not 404 Subject 10 the condition thit you ae in

700 ook P tevms f the Liaren Ayesmant

Con J ] [Coma ]

The program searches for the machine.
',g If your machine is not found in the network or locally, the following
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window will appear.
Bx

Printers Not Found
Pome corviy read e notxe sl seerch resits

oy rtrh o
Sk “Sewrch agan” o Twect ot for mestance to frd o prrter

N 7 U Catie P e Oucorrected [rom you CGngLter, (1 S50 STEVert 000 from detectrs any
srrtens o O T far

()00 € s ek 1o ket o e sl i, tbend corvection of the griker

wton [ owaver | e )

* Check if you want to install the software without
connection of the printer.

- Check this option to install this program without a machine
connected. In this case, the print a test page window will be
skipped, and completes the installation.

* Search again

When you press this button, the firewall notice window

appears.

- Turn off the firewall and Search again. For Window
operating system, click Start > Control Panel > Windows
Firewall, and inactivate this option. For other operating
system, refer to its on-line guide.

- Turn off the firewall from the third party's program beside
the operating system. Refer to the manual provided by
individual programs.

« Direct Input

The Direct Input allows you to search a specific machine on

the network.

- Search by IP address: Enter the IP address or the host
name. Then click Next.

To verify your machine’s IP address, print a network
configuration report (See "Printing a machine report" on
page 69).

- Search by network path: To find a shared machine (UNC
Path), enter the shared name manually or find a shared
printer by clicking the Browse button. Then click Next.

¢ Help

If your machine is not connected to the computer or network,

This help button gives you the detailed information about how

to connect the machine.

. The searched machines will be shown on the screen. Select the one you
wish to use and click Next.

w If the driver searched only one machine, the confirmation window
appears.

. After the installation is finished, a window asking you to print a test page
appears. If you want to print a test page, click Print a test page.

Otherwise, just click Next and skip to step 8.
. If the test page prints out correctly, click Yes.
If not, click No to reprint it.

. If you want to register your machine on Samsung website, click On-line
Registration.

9.

',g

w If your machine is not connected yet to the computer, click How to
connect?. How to connect? gives detailed information about
how to connect the machine. Follow the instructions in the window.

Click Finish.
If the printer driver does not work properly, follow the steps below to
repair or reinstall the driver.
a) Make sure that the machine is connected to your machine and
powered on.
b) From the Start menu, select Programs or All Programs >
Samsung Printers > your printer driver name > Maintenance.

c) Select the option you wish to execute, then follow the instruction
on the window.

Macintosh

The software CD that came with your machine provides you with the Driver
files that allow you to use the CUPS driver or PostScript driver (only
available when you use a machine, which supports the PostScript driver) for
printing on a Macintosh computer.

1.

2o@NOU AN

1".

12

13.

14.

15.

16.

Make sure that the machine is connected to your computer and powered
on.

Insert the supplied software CD into your CD-ROM drive.

Double-click the CD-ROM icon that appears on your Macintosh desktop.
Double-click the MAC_Installer folder.

Double-click the Installer OS X icon.

Enter the password and click OK.

The Samsung Installer window opens. Click Continue.

Read the license agreement and click Continue.

Click Agree to agree to the license agreement.

. Select Easy Install and click Install. Easy Install is recommended for

most users. All components necessary for machine operations will be
installed.

If you select Custom Install, you can choose individual components to
install.

When the message which warns that all applications will close on your
computer appears, click Continue.

. After the installation is finished, click Quit.

Open the Applications folder > Utilities > Print Setup Utility.

*  For Mac OS X 10.5 ~ 10.6, open the Applications folder > System
Preferences and click Print & Fax.

Click Add on the Printer List.

+ For Mac OS X 10.5 ~ 10.6, click the “+” icon; a display window will
pop-up.

For Mac OS X 10.3, select the USB tab.

e For Mac OS X10.4, click Default Browser and find the USB
connection.

«  For Mac OS X 10.5 ~ 10.6, click Default and find the USB
connection.

For Mac OS X 10.3, if Auto Select does not work properly, select

Samsung in Printer Model and your machine name in Model Name.

»  For Mac OS X 10.4, if Auto Select does not work properly, select
Samsung in Print Using and your machine name in Model.

» ForMac OS X 10.5 ~ 10.6, if Auto Select does not work properly,
select Select a driver to use... and your machine name in Print
Using.

Your machine appears on the Printer List, and is set as the default

machine.

Getting started_ 27



17. Click Add.

[,g

If the printer driver does not work properly, uninstall the driver and

reinstall it.

Follow steps below to uninstall the driver for Macintosh.

a) Make sure that the machine is connected to your computer and
powered on.

b) Insert the supplied software CD into your CD-ROM drive.

c) Double-click CD-ROM icon that appears on your Macintosh
desktop.

d) Double-click the MAC_Installer folder.

e) Double-click the Installer OS X icon.

f) Enter the password and click OK.

g) The Samsung Installer window opens. Click Continue.

h) Select Uninstall and click Uninstall.

i)  When the message which warns that all applications will close on
your computer appears, Click Continue.

j)  When the uninstall is done, click Quit.

Linux

You need to download Linux software packages from the Samsung website
to install the printer software.

Follow the steps below to install the software.

Installing the Unified Linux Driver

1.

2.

7.

Make sure that the machine is connected to your computer and
powered on.

When the Administrator Login window appears, type in root in the
Login field and enter the system password.

(g You must log in as a super user (root) to install the machine
software. If you are not a super user, ask your system
administrator.

From the Samsung website, download the Unified Linux Driver
package to your computer.

Right-click the Unified Linux Driver package and extract the
package.

Double click cdroot > autorun.

When the welcome screen appears, click Next.

Unified Linux Driver Installer 3

Welcome 1o the Unified Linux Driver
Installation wizatd!
E . This prog instait y
- for printers and MFP devices.
J { Click Nextto continue with the Selup program
Help cpock | | met» | gGancel |

When the installation is complete, click Finish.

The installation program added the Unified Driver Configurator desktop
icon and the Unified Driver group to the system menu for your
convenience. If you have any difficulties, consult the on screen help that
is available through your system menu or from the driver package
Windows applications, such as Unified Driver Configurator.

Installing the SmartPanel

1.

2.

3.

4.
5.

Make sure that the machine is connected to your computer and
powered on.

When the Administrator Login window appears, type in root in the
Login field and enter the system password.

You must log in as a super user (root) to install the machine
software. If you are not a super user, ask your system
administrator.

From the Samsung website, download the Smart Panel package to
your computer.

Right-click the Smart Panel package and extract the package.
Double click cdroot > Linux > smartpanel > install.sh.

Installing the Printer Settings Utility

1.

2.

4,

5.

',g
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Make sure that the machine is connected to your computer and
powered on.

When the Administrator Login window appears, type in root in the
Login field and enter the system password.

You must log in as a super user (root) to install the machine
software. If you are not a super user, ask your system
administrator.

From the Samsung website, download the Printer Settings Utility
package to your computer.

Right-click the Printer Settings Utility package and extract the
package.
Double click cdroot > Linux > psu > install.sh.
If the printer driver does not work properly, uninstall the driver and
reinstall it.
Follow the steps below to uninstall the driver for Linux.
a) Make sure that the machine is connected to your computer and
powered on.

When the Administrator Login window appears, type in “root
in the Login field and enter the system password.

You must log in as a super user (root) to uninstall the printer
driver. If you are not a super user, ask your system
administrator.

c) Click the icon at the bottom of the desktop. When the Terminal
screen appears, type in:

[root@localhost root]#cd /opt/Samsung/mfp/uninstall/
[root@localhost uninstall]#./uninstall.sh

d) Click Uninstall.

e) Click Next.

f) Click Finish.

b
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- =

SHARING YOUR MACHINE LOCALLY

Follow the steps below to set up computers to share your machine locally.



If the Host computer is directly connected to the machine with a USB cable
and is also connected to the local network environment, the client computer
connected to the local network can use the shared machine through the
host computer to print.

I
&)
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Host computer A computer which is directly connected to
the machine by USB cable.

®

Client computers | Computers which use the machine shared
through the host computer.

Windows

Setting up a host computer

1.

©oNo

Install your printer driver (See "Installing USB connected machine’s
driver" on page 26, "Installing network connected machine’s driver"
on page 33).

Click the Windows Start menu.

For Windows 2000, select Settings > Printers.

« For Windows XP/Server 2003, select Printers and Faxes.

« For Windows Server 2008/Vista, select Control Panel >
Hardware and Sound > Printers.

* For Windows 7, select Control Panel > Devices and Printers.

« For Windows Server 2008 R2, select Control Panel > Hardware
> Devices and Printers.

Right-click the printer icon.

For Windows XP/Server 2003/Server 2008/Vista, press Properties.

For Windows 7 or Windows Server 2008 R2, from context menus,

select the Printer properties.

(g If Printer properties item has a » mark, you can select other
printer drivers connected with the selected printer.

Select the Sharing tab.

Check Change Sharing Options.
Check the Share this printer checkbox.
Fill in the Share Name field. Click OK.

Setting up a client computer

1.

Install your printer driver (See "Installing USB connected machine’s
driver" on page 26, "Installing network connected machine’s driver"
on page 33).

Click the Windows Start menu.

Select All programs > Accessories > Windows Explorer.

Enter the IP address of the host computer in the address bar and
press Enter in your keyboard.

@ In case host computer requires a User name and Password,
fill in User ID and password of the host computer account.

Right-click the printer icon you want to share and select Connect.
If a set up complete message appears, click OK.

7. Open the file you want to print and start printing.

Macintosh

'g The following steps are for Mac OS X 10.5~10.6. Refer to Mac Help
for other OS versions.

Setting up a host computer
1. Install your printer driver (See "Macintosh" on page 27).

2. Open the Applications folder > System Preferences and click
Print & Fax.

3. Select the printer to share in the Printers list.
4. Select Share this printer.

Setting up a client computer
1. Install your printer driver (See "Macintosh" on page 27).

2. Open the Applications folder > System Preferences and click
Print & Fax.

3. Click the “+” icon.
A display window showing the name of your shared printer appears.
4. Select your machine and click Add.
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NEtWOrk setup

(Clp-320n(K)/Clo-321n/clp-325w(K) only)

This chapter gives you step-by-step instructions for setting up the network connected machine and software.

This chapter includes:

* Network environment
« Introducing useful network programs

NETWORK ENVIRONMENT

You need to set up the network protocols on the machine to use it as your
network machine. You can set up the basic network settings through the
machine's control panel.

The following table shows the network environments supported by the
machine:

ITEM REQUIREMENTS

Network interface » Ethernet 10/100 Base-TX

» Network Interface 802.11 b/g/n wireless
LAN (CLP-325W(K) only)

Network operating system |+ Windows 2000/Server 2003 /Server
2008/XP/Vista/7/Server 2008 R2

* Various Linux OS
* Mac OS X10.3~10.6

Network protocols * TCP/IPv4
+ DHCP, BOOTP
+ DNS, WINS, Bonjour, SLP, UPnP

» Standard TCP/IP Printing (RAW), LPR,
IPP

*  SNMPv 1/2/3, HTTP, IPSec

« TCP/IPv6 (DHCP, DNS, RAW, LPR,
SNMPv 1/2/3, HTTP, IPSec)
See "IPv6 configuration" on page 32.

Wireless security * Authentication: Open System, Shared
Key, WPA Personal, WPA2 Personal
(PSK)
» Encryption: WEP64, WEP128, TKIP,
AES

INTRODUCING USEFUL NETWORK PROGRAMS

There are several programs available to setup the network settings easily in
network environment. For the network administrator especially, managing
several machines on the network is possible.

w Before using the programs below, set the IP address first.
SyncThru™ Web Service

Web server embedded on your network machine, which allows you to:

* Using a wired network
» Installing network connected machine’s driver

» Configure the network parameters necessary for the machine to connect
to various network environments.

* Customize machine settings.
See "Using SyncThru™ Web Service" on page 65.

SetlP

This utility program allows you to select a network interface and manually
configure the IP addresses for use with the TCP/IP protocol.

» See "IPv4 setting using SetlP Program (Windows)" on page 31.
» See "IPv4 setting using SetlP Program (Macintosh)" on page 31.
» See "IPv4 setting using SetlP Program (Linux)" on page 32.

',g TCP/IPv6 is not supported by this program.

USING A WIRED NETWORK

You must set up the network protocols on your machine to use it on your
network. This chapter will show you how this is easily accomplished.

You can use network after connecting network cable to a corresponding

port on your machine.
[ | [ Y
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Printing network configuration report

You can print a Network Configuration Report from the machine's control
panel that will show the current machine’s network settings. This will help
you to set up a network and troubleshoot problems.

To print the report:

In ready mode, press and hold the (cancel button) for about 5 seconds.
You can find your machine’s MAC address and IP address.

For example:

*  MAC Address: 00:15:99:41:A2:78

* IP Address: 192.0.0.192
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Setting IP address

Firstly, you have to set up an IP address for network printing and
managements. In most cases a new IP address will be automatically
assigned by a DHCP (Dynamic Host Configuration Protocol) server located
on the network.

In a few situations the IP address must be set manually. This is called a
static IP and is often required in corporate Intranets for security reasons.

* DHCP IP assignment: Connect your machine to the network, and wait a
few minutes for the DHCP server to assign an IP address to the
machine. Then, print the Network Configuration Report as explained
above. If the report shows that the IP address has changed, the
assignment was successful. You will see the new IP address in the
report.

« Static IP assignment: Use SetIP program to change the IP address
from your computer.

In an office environment, we recommend that you contact a network
administrator to set this address for you.

IPv4 configuration

IPv4 setting using SetlP Program (Windows)

This program is for manually setting the network IP address of your
machine using its MAC address to communicate with the machine. A
MAC address is the hardware serial number of the network interface and
can be found in the Network Configuration Report.

For using SetIP program, disable the computer firewall before continuing
by performing the following:

1. Open Start > Control Panel.

2. Double click Security Center.

3. Click Firewall.

4. Disable the firewall.

Installing the program

1. Insert the Printer Software CD-ROM provided with your machine.
When the driver CD runs automatically, close that window.

2. Start Windows Explorer and open the X drive. (X represents your
CD-ROM drive.)

Double-click Application > SetlP.

Double-click Setup.exe to install this program.

Click OK. If necessary, select a language from the drop-down list.
Follow the instructions in the window and complete the installation.

il

Starting the program
1. Connect your machine to the network with a network cable.
2. Turned on the machine.

3. From the Windows Start menu, select All Programs > Samsung
Printers > SetIP > SetIP.

4. Click onthe £3 icon (third from left) in the SetIP window to open the
TCP/IP configuration window.

5. Enter the machine’s new information into the configuration window
as follows. In a corporate intranet, you may need to have this
information assigned by a network manager before proceeding.

TCP/IP. Configuration X
TCR/IP I
Mac Address |
IP Addrees : .
Subnet Mask : .
Default Gateway . .
Apply Cancel Reset

* MAC Address: Find the machine’s MAC address from the
Network Configuration Report and enter it without the colons.
For example, 00:15:99:29:51:A8 becomes 0015992951A8.

« IP Address: Enter a new IP address for your printer.

For example, if your computer’s IP address is 192.168.1.150,
enter 192.168.1.X. (X is number between 1 and 254 other than
the computer’s address.)

* Subnet Mask: Enter a Subnet Mask.
* Default Gateway: Enter a Default Gateway.

6. Click Apply, and then click OK. The machine will automatically print
the Network Configuration Report. Confirm that all the settings are
correct.

7. Click Exit to close the SetIP program.
8. If necessary, restart the computer’s firewall.

IPv4 setting using SetlP Program (Macintosh)
For using SetlP program, disable the computer firewall before continuing
by performing the following:

[,g The path and Uls may differ by Mac OS version. Refer to the Mac
OS manual.

Open System Preferences.
Click Security.

Click the Firewall menu.
Turn firewall off.

The following instructions may vary for your model.

Connect your machine to the network with a network cable.

Insert the Installation CD-ROM, and open the disk window, select

MAC_Installer > MAC_Printer > SetlP > SetIPApplet.html.

Double click the file and Safari will automatically open, then select

Trust. The browser will open the SetIPApplet.html page that shows

the printer’s name and IP address information.

4. Click on the £t icon (third from left) in the SetlP window to open the
TCP/IP configuration window.

5. Enter the machine’s new information into the configuration window

as follows. In a corporate intranet, you may need to have this

information assigned by a network manager before proceeding.

* MAC Address: Find the machine’s MAC address from the
Network Configuration Report and enter it without the colons.

.’".—‘g PODdN=
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For example, 00:15:99:29:51:A8 becomes 0015992951A8.
« IP Address: Enter a new IP address for your printer.

For example, if your computer’s IP address is 192.168.1.150,
enter 192.168.1.X. (X is number between 1 and 254 other than
the computer’s address.)

+ Subnet Mask: Enter a Subnet Mask.
+ Default Gateway: Enter a Default Gateway.

6. Select Apply, then OK, and OK again. The printer will automatically
print the configuration report. Confirm that all the settings are correct.
Quit Safari. You may close and eject the installation CD-ROM. If
necessary, restart the computer’s firewall. You have successfully
changed the IP address, subnet mask, and gateway.

IPv4 setting using SetlP Program (Linux)
SetlP program should be automatically installed during the printer driver
installation.

'Q The path and Uls may differ by Linux OS version. Refer to the
Linux OS manual to turn firewall off.

1. Print the machine’s network configuration report to find your
machine’s MAC address.

Open the /opt/Samsung/mfp/share/utils/.

Double click the SetIPApplet.html file.

Click to open the TCP/IP configuration window.

Enter the network card’s MAC address, IP address, subnet mask,
default gateway, and then click Apply.

When you enter the MAC address, enter it without a colon(:).

Qo oeN

6. The machine prints the network configuration report. Confirm all the
settings are correct.

7. Close the SetlP program.

IPv6 configuration
A TCP/IPv6 is supported properly only in Windows Vista or higher.

[g If the IPv6 network seems to not be working, set all the network setting
to the factory defaults and try again (See "Restoring factory default
settings using SyncThru™ Web Service" on page 33).

To use the IPv6 network environment, follow the next procedure to use the
IPv6 address.

The machine is provided with IPv6 feature on.
1. Connect your machine to the network with a network cable.
2. Turn on the machine.

3. Print a Network Configuration Report from the machine’s control
panel that will check IPv6 addresses.

4. Select Start > Control Panel > Hardware and Sound > Printers > Add
Printer.

5. Click Add a local printer on the Add Printer windows.
6. Follow the instruction on the window.

',g If the machine does not work in the network environment, activate
IPv6. Refer to the next section followed by.

Printing network configuration report

You can print a Network Configuration Report from the machine's
control panel that will show the current machine’s network settings. This
will help you to set up a network and troubleshooting problems.

To print the report:

In ready mode, press and hold the (cancel button) for about 5
seconds. You can find your machine’s MAC address and IP address.
For example:

*  MAC Address: 00:15:99:41:A2:78

* IP Address: 192.0.0.192

Setting IPv6 addresses
Machine supports following IPv6 addresses for network printing and
managements.

* Link-local Address: Self-configured local IPv6 address. (Address
starts with FE80.)

+ Stateless Address: Automatically configured IPv6 address by a
network router.

+ Stateful Address: IPv6 address configured by a DHCPV6 server.
* Manual Address: Manually configured IPv6 address by a user.

Manual address configuration
1. Start a web browser such as Internet Explorer that supports IPv6
addressing as a URL (See "SyncThru™ Web Service" on page 30).

For IPv4, enter the IPv4 address (http:/xxx.xxx.xxx.xxx) in the
address field and press the Enter key or click Go.

2. When the SyncThru™ Web Service window opens, click Network
Settings.

3. Click TCP/IPv6.

Enable the Manual Address In the TCP/IPv6 section.

5. Select the Address/Prefix and click the Add button, then the router
prefix will automatically be entered into the address field.
Enter the rest of address. (ex: 3FFE:10:88:194::AAAA. “A” is the
hexadecimal 0 through 9, A through F.)

6. Click the Apply button.

>

Installing printer driver

Driver installation for network printer in IPv6 network environment is
same as TCP/IPv4 (See "Installing network connected machine’s driver
on page 33).

Select TCP/IP Port and when the list of machines are displayed, simply
select your machine's IPv6 address.

Using SyncThru™ Web Service

1. Start a web browser such as Internet Explorer that supports IPv6
addressing as a URL.

2. Select one of the IPv6 addresses (Link-local Address, Stateless
Address, Stateful Address, Manual Address) from Network
Configuration Report.

3. Enter the IPv6 addresses. (ex: http://[FE80::215:99FF:FE66:7701])
A Address must be enclosed in '[]' brackets.

Restoring factory default settings using SyncThru™
Web Service
1. Start a web browser such as Internet Explorer, Safari or Firefox and
enter your machine’s new IP address in the browser window.
For example,

|&] http://192,168,1,13%

2. Click Go to access the SyncThru™ Web Service.
3. Click Login on the upper right of the SyncThru™ Web Service website.
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A log-in page appears.
4. Type in the ID and Password then click Login.

If it’s your first time logging into SyncThru™ Web Service, type in the
below default ID and password.

* ID: admin
* Password: sec00000

5. When the SyncThru™ Web Service window opens, click Settings >
Network Settings > Restore Default.

6. Click Clear for network.
7. Turn off and restart machine to apply settings.

INSTALLING NETWORK CONNECTED
MACHINE’S DRIVER

You must install the printer driver software for printing. The software
includes drivers, applications, and other user friendly programs.

Make sure that the network setup for your machine is completed. All
applications should be closed on your computer before beginning
installation.

Windows

This is recommended for most users. All components necessary for

machine operations will be installed.

Follow the steps below:

1. Make sure that the machine is connected to the network and powered
on.

2. Insert the supplied software CD into your CD-ROM drive.

* The software CD should automatically run and an installation window
appear.

» If the installation window does not appear, click Start and then Run.
Type X:\Setup.exe, replacing “X” with the letter which represents
your CD-ROM drive. Click OK.

» If you use Windows Vista, Windows 7 and Windows Server 2008 R2,
click Start > All programs > Accessories > Run.

Type X:\Setup.exe replacing “X” with the letter which represents
your CD-ROM drive and click OK.

» If the AutoPlay window appears in Windows Vista, Windows 7 and
Windows Server 2008 R2, click Run Setup.exe in Install or run
program field, and click Continue or Yes in the User Account
Control window.

3. Select Install now.
0 BX

‘3 Install Now &

:j-J \iew User's Guide

Q@ Wireless Setting and Installation -

@ Advanced Installation —

Installation Language: iE,‘gﬁ;h v Exit

If necessary, select a language from the drop-down list.

For CLP-325W(K) installation window, you can access
Wireless Setting and Installation menu. The Wireless
Setting and Installation allows you to install a wireless
network to connect to the machine with USB cable (See
"Setting a wireless network with USB cable" on page 38).
The Advanced Installation has two options, Custom
Installation and Install Software Only. The Custom
Installation allows you to select the machine’s connection and
choose individual component to install. The Install Software
Only allows you to install the supplied software such as Smart
Panel. Follow the guide in the window.

4. Read License Agreement, and select | accept the terms of the
License Agreement. Then, click Next.

o 1 Wekcome
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License Agreement

7. \cenae Agreconent Fiease resd the Licenss Areemere.

+ 2 Semching Pristers E 3

P— — I B g
END USER LICENSE AGREEMENT FOR SAMSUNG ELECTROMCS SOFTWARE -
PRODUCT
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ram searches the machine.

',g If your machine is not found in the network or locally, the following
window will appear.
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Check if you want to install the software without

connection of the printer.

- Check this option to install this program without a machine
connected. In this case, the print a test page window will be
skipped, and completes the installation.

Search again

When you press this button, the firewall notice window

appears;
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9.

- Turn off the firewall and Search again. For Window
operating system, click Start > Control Panel > Windows
Firewall, and inactivate this option. For other operating
system, refer to its on-line guide.

- Turn off the firewall from the third party's program beside
the operating system. Refer to the manual provided by
individual programs.

* Direct Input

The Direct Input allows you to search a specific machine on

the network.

- Search by IP address: Enter the IP address or the host
name. Then click Next.

To verify your machine’s IP address, print a network
configuration report (See "Printing a machine report" on
page 69).

- Search by network path: To find a shared machine (UNC
Path), enter the shared name manually or find a shared
printer by clicking the Browse button. Then click Next.

* Help

If your machine is not connected to the computer or network,

This help button gives you the detailed information about how

to connect the machine.

The searched machines will be shown on the screen. Select the one you
wish to use and click Next.

’Q If the driver searched only one machine, the confirmation window
appears.

After the installation is finished, a window asking you to print a test page
appears. If you want to print a test page, click Print a test page.
Otherwise, just click Next and skip to step 8.

If the test page prints out correctly, click Yes.

If not, click No to reprint it.

If you want to register your machine on Samsung website, click On-line
Registration.

',g If your machine is not connected yet to the computer, click How to
connect?. How to connect? gives detailed information about

how to connect the machine. Follow the instructions in the window.

Click Finish.

',g + After the driver setup, you may enable firewall.

+ If the printer driver does not work properly, follow the steps below
to repair or reinstall the driver.

a) Make sure that the machine is connected to your machine and
powered on.

b) From the Start menu, select Programs or All Programs >
Samsung Printers > your printer driver name >
Maintenance.

c) Select the option as you wish, follow the instruction on the
window.

Macintosh

1.

o ar 0N

Make sure that the machine is connected to your network and powered
on. Also, your machine’s IP address should have been set.

Insert the supplied software CD into your CD-ROM drive.

Double-click the CD-ROM icon that appears on your Macintosh desktop.

Double-click the MAC_Installer folder.
Double-click the Installer OS X icon.
Enter the password and click OK.

a a0 oo~
gl

12.

13.
14.

15.

16.

17.

18.
19.

20.

21.

The Samsung Installer window opens. Click Continue.
Read the license agreement and click Continue.
Click Agree to agree to the license agreement.

. The Samsung Installer window opens. Click Continue.
. Select Easy Install and click Install. Easy Install is recommended for

most users. All components necessary for machine operations will be
installed.

» If you select Custom Install, you can choose individual components
to install.

The message which warns that all applications will close on your

computer appears. Click Continue.
w .

select Typical installation for a network printer and then
click OK.

« If you select Typical installation for a network printer, the
SetlP program automatically runs. If the machine has already
configured network information, close the SetIP program. Go to
the next step.

After the installation is finished, click Quit.
Open the Applications folder > Utilities > Print Setup Utility.

*  For Mac OS X 10.5~10.6, open the Applications folder > System
Preferences and click Print & Fax.
Click Add on the Printer List.
* For Mac OS X 10.5~10.6, click the “+” icon; a display window will
pop-up.
For Mac OS X 10.3, select the IP Printing tab.
e For Mac OS X 10.4, click IP Printer.
e For Mac OS X 10.5~10.6, click IP.
Select Socket/HP Jet Direct in Printer Type.
When printing a document containing many pages, printing
performance may be enhanced by choosing Socket for Printer
Type option.

If a window asking you to select an installation type appears,

Enter the machine’s IP address in the Printer Address field.

Enter the queue name in the Queue Name field. If you cannot determine

the queue name for your machine server, try using the default queue

first.

For Mac OS X 10.3, if Auto Select does not work properly, select

Samsung in Printer Model and your machine name in Model Name.

»  For Mac OS X 10.4, if Auto Select does not work properly, select
Samsung in Print Using and your machine name in Model.

* For Mac OS X 10.5~10.6, if Auto Select does not work properly,
select Select a driver to use... and your machine name in Print
Using.

Your machine appears on the Printer List, and is set as the default

machine.

Click Add.
’g If the printer driver does not work properly, uninstall the driver and

reinstall it.

Follow steps below to uninstall the driver for Macintosh.

a) Make sure that the machine is connected to your computer and
powered on.

b) Insert the supplied software CD into your CD-ROM drive.

c) Double-click CD-ROM icon that appears on your Macintosh
desktop.

d) Double-click the MAC_Installer folder.
e) Double-click the Installer OS X icon.
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f) Enter the password and click OK.
d) The Samsung Installer window opens. Click Continue.
h) Select Uninstall and click Uninstall.

i)  When the message which warns that all applications will close
on your computer appears, Click Continue.

j)  When the uninstall is done, click Quit.

Linux

Install Linux Driver

1. Make sure that the machine is connected to your network and
powered on. Also, your machine’s IP address should have been set.

2. From the Samsung website, download the Unified Linux Driver
package to your computer.

Right-click the Unified Linux Driver package and extract the
package.

Double click cdroot > autorun.

The Samsung Installer window opens. Click Continue.

The Add printer wizard window opens. Click Next.

Select Network printer and click Search button.

The Printer’s IP address and model name appears on list field.
9. Select your machine and click Next.

10. Input the printer description and Next

11. When the add printer is done, click Finish.

12. When the install is done, click Finish.

Add network Printer

Double-click the Unified Driver Configurator.

Click Add Printer...

The Add printer wizard window opens. Click Next.

Select Network printer and click the Search button.

The printer’'s IP address and model name appears on list field.
Select your machine and click Next.

Input the printer description and Next

When the add printer is done, click Finish.

[ad
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wireless network setup (Clo-325w(k) only)

This chapter gives you step-by-step instructions for setting up the wireless network connected machine and software.

This chapter includes:

* Using a wireless network with WPS button on the control panel
« Using a wireless network from the computer
« Setting a wireless network with USB cable

For more information about the network environment, network
programs, and installing network connected machine’s driver, refer to
the following chapters.

» See "Network environment" on page 30.
« See "Introducing useful network programs" on page 30.
« See "Installing network connected machine’s driver" on page 33.

USING A WIRELESS NETWORK WITH WPS
BUTTON ON THE CONTROL PANEL

If your machine and an access point (or wireless router) support Wi-Fi
Protected Setup™(WPS), you can easily configure the wireless network

settings by pressing the WPS ( \" ) button on the control panel without a
computer '

Items to prepare

You need to ensure you have the following items ready to use:

« Check if the access point (or wireless router) supports Wi-Fi Protected
Setup™(WPS).

« Check if your machine supports Wi-Fi Protected Setup™(WPS).

Choosing your network connection

There are two methods to connect your machine to a wireless network by
using the WPS ( ‘, ) button on the control panel.

The Push Button Configuration (PBC) method allows you to connect your
machine to a wireless network by pressing the WPS ( ‘, ) button on the
control panel of your machine and the WPS (PBC) button on a Wi-Fi
Protected Setup™(WPS)-enabled access point (or wireless router)
respectively.

The Personal Identification Number (PIN) method helps you connect your
machine to a wireless network by entering the supplied PIN information on a
Wi-Fi Protected Setup™(WPS)-enabled access point (or wireless router).

The PBC mode is recommended for a typical wireless network environment.

w Access point (or wireless router) that supports WPS (Wi-Fi Protected
Setup™) has the symbol shown below.

Wi-Fi PROTECTED 1
SETUP

Setting a wireless network

Connecting to a wireless network in PBC mode

To connect your machine to a wireless network, follow the following
steps:

You need to check the status of the wireless LED.

Setting a wireless network with network cable
Completing the installation
Troubleshooting

1. Press the WPS ( ¢§ ) button on the control panel for less than two
seconds.

+ == The light blinks slowly on wireless LED. The machine
starts connecting to the wireless network. The LED blinks slowly
for up to two minutes until you press the PBC button on access
point (or wireless router).

2. ¢ : Press the WPS (PBC) button on the access point (or wireless
router).

+ == The light blinks fast on the wireless LED. The machine is
connecting to the access point (or wireless router).

*« _—_: When the machine is successfully connected to the
wireless network, the wireless LED light stays on.

« The resulting report is automatically printed out.

>

w If your machine fails to connect to the wireless network, the
wireless LED is off, and the error report is automatically
printed out. Try again to connect to the wireless network
after solving the connection problem.

Connecting to the wireless network in PIN mode

To connect your machine to the wireless network, follow the following
steps:
You need to check the status of the wireless LED.
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1. Press and hold the WPS (' ¢§ ) button on the control panel for
more than two seconds. ‘
« The report including PIN number is automatically printed out.

>

« == The light blinks slowly on the wireless LED. The machine
starts connecting to access point (or wireless router).
2. You need to enter eight-digit PIN number within two minutes to the

computer which is connected to the access point (or wireless router).

The LED blinks slowly for up to two minutes until you enter the

eight-digit PIN number

+ == The light blinks fast on the wireless LED. The machine is
connecting to the access point (or wireless router). When the
machine is successfully connected to the wireless network, the
wireless LED light stays on.

*« __: The resulting report is automatically printed out.

>

(g If your machine fails to connect to the wireless network, the
wireless LED is off, and the error report is automatically
printed out. Try again to connect to the wireless network
after solving the connection problem.

Re-connecting to the wireless network

When the wireless function is off, the machine automatically tries to
re-connect to the access point (or wireless router) with the previously used
wireless connection settings and address.

',g In_the following cases, the machine automatically re-connects to the
wireless network:
* The machine is turned off and on again.
* The WLAN is turned off and on again.
» The access point (or wireless router) is turned off and on again.

« If there is no previously used access point (or wireless router), or
the network settings have been changed.

Canceling a wireless network connection process
To cancel the wireless network connection function when the machine is
connecting to the wireless network, press the WPS ( ‘) ) button on the

control panel again. The wireless LED is off. The Wait 2 minutes for
Reconnecting message is to be automatically printed out.

Disconnecting a wireless network connection

To disconnect the wireless network connection, press the WPS ( ‘, )

button on the control panel again.

*  When the Wi-Fi Network is in idle mode: The machine isimmediately
disconnected from the wireless network, and the wireless LED is off.

*  When the Wi-Fi Network is being used: While the machine waits until
the current job is finished, the light blinks fast on the wireless LED. Then,
the wireless network connection is automatically disconnected. The

wireless LED is off.

USING A WIRELESS NETWORK FROM THE
COMPUTER

Choosing your network connection

Typically, you can only have one connection between your computer and
the machine at a time. There are types of network connections to consider.
*  Wireless network without access point (Ad-Hoc mode)

* Wireless network with an access point (Infrastructure mode)

How to print a network configuration report

You can identify the network settings of your machine by printing a network
configuration report.

To print the report:

In ready mode, press and hold the Cancel button for about 5 seconds. You
can find your machine’s MAC address and IP address.

For example:

*  MAC Address: 00:15:99:41:A2:78

+ IP Address: 192.0.0.192

IP addresses

Every device in a network has a unique numerical address called an IP

Address. Your machine came with a Default IP address of 192.0.0.192,

which you can verify by printing out a Network Configuration Report or

Configuration Report.

* DHCP IP assignment: Connect your machine to the network, and wait a
few minutes for the DHCP server to assign an IP address to the
machine. Then, print the Network Configuration Report as explained
above. If the report shows that the IP address has changed, the
assignment was successful. You will see the new IP address in the
report.

» Static IP assignment: Use the SetlP program to change the IP address
from your computer (See "Setting IP address" on page 31).

In an office environment, we recommend that you contact a network

administrator to set this address for you.

Wireless network nhame and network key

Wireless networks require higher security, so when an access point is first
set up, a network name (SSID), the type of security used, and a Network
Key are created for the network. Locate this information before proceeding
with the machine installation.
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Infrastructure mode
This is an environment generally used for homes
]_l_ and SOHOs. This mode uses an access point to
oy communicate with the wireless machine.
AN % +  See "Installing the machine on a wireless
' © network with an access point (Windows)" on
page 38.
+ See "Installing the machine on a wireless
network with an access point (Macintosh)" on
page 41.

Ad-Hoc mode
> 7 This mode does not use an access point. The
N ”"_ wireless computer and wireless machine

oz

2
W 2 communicates directly.

QE‘SW 'L-‘\'\'\I© + See "Installing the machine on an Ad-Hoc
= N wireless network (Windows)" on page 39.

« See "Installing the machine on an Ad-Hoc
wireless network (Macintosh)" on page 42.

w After choosing your configuration, follow the simple directions for your
computer operating system, but first locate the software CD supplied
with the machine before proceeding.

Installing a wireless network with cables

You can install a wireless network to connect to the machine with either a
USB cable or a network cable. For most users, we recommend using a USB
cable with the program provided in the supplied software CD.

The following are two ways to install a wireless network with cables.

« With a USB cable: You can simply set up a wireless network using the
program in the supplied software CD. Only Windows and Macintosh
operating system are supported (See "Setting a wireless network with
USB cable" on page 38).

’Q You can also install a wireless network in Printer Settings Utility
with USB cable after installing driver. (Windows and Macintosh
operating system are supported.)

« With a network cable: You can set up a wireless network using the
SyncThru™ Web Service program (See "Setting a wireless network with
network cable" on page 43).

SETTING A WIRELESS NETWORK WITH USB
CABLE

w Refer to your network administrator, or the person that set up your
wireless network, for information about your network configuration.

Installing the machine on a wireless network with an
access point (Windows)

Items to prepare

Ensure you have next items ready.

» Access point

* Network-connected computer

+ Software CD that provided with your machine

* The machine installed with a wireless network interface
+ USB cable

Creating the infrastructure network in Windows
When the items are ready, follow below steps:

1. Check whether the USB cable is connected to the machine.
2. Turn on your computer, access point and machine.

3. Insert the supplied software CD into your CD-ROM drive.

« The software CD should automatically run and an installation
window appears.

« If the installation window does not appear, click Start and then
Run. Type X:\Setup.exe, replacing “X” with the letter which
represents your CD-ROM drive. Click OK.

* If you use Windows Vista, Windows 7 or Windows Server 2008
R2 click Start > All programs > Accessories > Run.

Type X:\Setup.exe replacing “X” with the letter which represents
your CD-ROM and click OK.

« Ifthe AutoPlay window appears in Windows Vista, Windows 7 or
Windows Server 2008 R2, click Run Setup.exe in Install or run
program field, and click Continue or Yes in the User Account
Control window.

4. Select the Wireless Setting and Installation option.
° -BX

T
"ﬁ Install Now &

‘3-1 View User's Guide j-

5 ) ‘Wireless Setting and Installation

& avanced instalaion

Installation Langusge:  [Engich 9

« Install Now: If you have set the wireless network, click this
button to install the printer driver to use the wireless network
machine. If you have not set the wireless network, click Wireless
Setting and Installation button to set the wireless network
before you click this button.

*  Wireless Setting and Installation: Configure the wireless
network settings of your printer with a USB cable then install the
printer driver. Only for the users who have not set up the wireless
connection before.

5. Read License Agreement, and select | accept the terms of the

License Agreement. Then, click Next.

6. The software searches the wireless network.

w If the searching has failed, you may check if the USB cable is
connected between the computer and machine properly, and
follow the instruction on the window.

7. After searching, the window shows the wireless network devices.
Select the name (SSID) of access point you are using and click
Next.

fg If you cannot find out the network name you want to choose, or
if you want to set the wireless configuration manually, click
Advanced Setting.
* Enter the wireless Network Name: Type the SSID of
access point you want (SSID is case-sensitive).
* Operation Mode: Select Infrastructure.
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« Authentication: Select an authentication type.
Open System: Authentication is not used, and encryption
may or may not be used, depending on the need for data
security.
Shared Key: Authentication is used. A device that has a
proper WEP key can access the network.
WPA Personal or WPA2 Personal: Select this option to
authenticate the print server based on WPA Pre-Shared
Key. This uses a shared secret key (generally called Pre
Shared Key pass phrase) which is manually configured on
the access point and each of its clients.

* Encryption: Select the encryption. (None, WEP64,
WEP128, TKIP, AES, TKIP AES)

* Network Key: Enter the encryption network key value.

» Confirm Network Key: Confirm the encryption network
key value.

*  WEP Key Index: If you are using the WEP Encryption,
select the appropriate WEP Key Index.

The wireless network security window does appear when the
access point has security setting.

The wireless network security window appears. The window
may differ according to its security mode, WEP or WPA.

* In case of WEP
Select Open System or Shared Key for the authentication
and enter WEP security key. Click Next.
WEP (Wired Equivalent Privacy) is a security protocol
preventing unauthorized access to your wireless network.
WEP encrypts the data portion of each packet exchanged
on a wireless network using a 64-bit or 128-bit WEP
encryption key.

* In case of WPA
Enter the WPA shared key and click Next.
WPA authorizes and identifies users based on a secret key
that changes automatically at regular intervals. WPA also
uses TKIP (Temporal Key Integrity Protocol) and AES
(Advanced Encryption Standard) for data encryption.

8. The window shows the wireless network setting and check if settings

are

right. Click Next.

For the DHCP method

If the IP address assignment method is DHCP, check if DHCP is

shown in the window. However, if it shows Static, click Change

TCPIIP to change the assignment method to DHCP.

For the Static method

If the IP address assignment method is Static, check if Static is

shown in the window. However, if it shows DHCP, click Change

TCPIIP to enter the IP address and other network configuration

values for the machine. Before entering the IP address for the

machine, you must know the computer’s network configuration

information. If the computer is set to DHCP, you must contact the

network administrator to get the static IP address.

Example)

If computer’s network information is as below:

- IP address: 169.254.133.42

- Subnet Mask: 255.255.0.0

Machine’s network information should be as below:

- IP address: 169.254.133. 43 (Use computer’s IP address,
with changed last three digits.)

- Subnet Mask: 255.255.0.0 (Use the computer’s subnet

mask.)

- Gateway: 169.254.133.1 (Change the last three digits from IP
address of your machine to 1.)

9. When the wireless network setting is completed, disconnect the USB
cable between the computer and machine. Click Next.
10. The Wireless Network Setting Complete window appears.
Select Yes if you accept the current settings and continue the setup
procedure.
Select No if you want to return to the beginning screen.
Then, click Next.
11. Click Next when the Confirm Printer Connection window appears.
12. Select the components to be installed. Click Next.

After selecting the components, you can also change the machine
name, set the machine to be shared on the network, set the machine
as the default machine, and change the port name of each machine.
Click Next.

13. After the installation is finished, a window asking you to print a test
page appears. If you want to print a test page, click Print a test
page.

Otherwise, just click Next and go to step 15.

14. If the test page prints out correctly, click Yes.
If not, click No to reprint it.

15. To register as a user of the machine in order to receive information
from Samsung, click On-line Registration.

16. Click Finish.

Installing the machine on an Ad-Hoc wireless
network (Windows)

If you do not have an access point (AP), you may still connect the machine
wirelessly to your computer by setting up an Ad-Hoc wireless network by
following the simple steps below.

Items to prepare

Ensure you have next items ready.

* Network-connected computer

+ Software CD that provided with your machine

* The machine installed with a wireless network interface
* USB cable

Creating the Ad-Hoc network in Windows

When the items are ready, follow below steps:

1. Check whether the USB cable is connected to the machine.
2. Turn on your computer and the wireless network machine.
3. Insert the supplied software CD into your CD-ROM drive.

« The software CD should automatically run and an installation
window appear.

« If the installation window does not appear, click Start and then
Run. Type X:\Setup.exe, replacing “X” with the letter which
represents your drive. Click OK.

* If you use Windows Vista, Windows 7 or Windows Server 2008
R2 click Start > All programs > Accessories > Run.

Type X:\Setup.exe replacing “X” with the letter which represents
your drive and click OK.

« Ifthe AutoPlay window appears in Windows Vista, Windows 7 or
Windows Server 2008 R2, click Run Setup.exe in Install or run
program field, and click Continue or Yes in the User Account
Control window.
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4. Select the Wireless Setting and Installation option.

0 - B
Plnmsuncg

’3 Install Now &

| View Users Guide -

@ Wireless Setting and Installation j»

& pavanced nstlation -

Installation Language: | English v Exit

« Install Now: If you have set the wireless network, click this
button to install the printer driver to use the wireless network
machine. If you have not set the wireless network, click Wireless
Setting and Installation button to set the wireless network
before you click this button.

* Wireless Setting and Installation: Configure the wireless
network settings of your printer with a USB cable then install the
printer driver. Only for the users who have not set up the wireless
connection before.

5. Read the License Agreement, and select | accept the terms of the

License Agreement. Then, click Next.

6. The software searches the wireless network.

(g If the software has failed to search the network, check if the
USB cable is connected properly between the computer and
machine, and follow the instruction on the window.

7. After searching the wireless network, a list of wireless network your
machine has searched appears.

If you want to use the Samsung default ad-hoc setting, select the last
wireless network on the list, which Network Name(SSID) is
airportthru and Signal is Printer Self Network.

Then, click Next.

If you want to use other ad-hoc settings, select other wireless
network from the list.

(g If you want to change ad-hoc settings click the Advanced

Setting button.

» Enter the wireless Network Name: Type in the SSID
name you want (SSID is case-sensitive).

* Operation Mode: Select Ad-hoc.

* Channel: Select the channel. (Auto Setting or 2412 MHz
to 2467 MHz).

+ Authentication: Select an authentication type.
Open System: Authentication is not used, and encryption
may or may not be used, depending on the need for data
security.
Shared Key: Authentication is used. A device that has a
proper WEP key can access the network.

* Encryption: Select the encryption. (None, WEP64,
WEP128)

* Network Key: Enter the encryption network key value.

+ Confirm Network Key: Confirm the encryption network
key value.

*  WEP Key Index: If you are using the WEP Encryption,

select the appropriate WEP Key Index.

fg The wireless network security window appears when the

ad-hoc network has security setting.

The wireless network security window appears. Select Open

System or Shared Key for the authentication and click Next.

«  WEP (Wired Equivalent Privacy) is a security protocol
preventing unauthorized access to your wireless network.
WEP encrypts the data portion of each packet exchanged
on a wireless network using a 64-bit or 128-bit WEP
encryption key.

8. The window which shows the wireless network setting appears.
Check the settings and click Next.

Before entering the IP address for the machine, you must know
the computer’s network configuration information. If the
computer’s network configuration is set to DHCP, the wireless
network setting should also be DHCP. Likewise, if the
computer’s network configuration is set to Static, the wireless
network setting should also be Static.

If your computer is set to DHCP and you want to use Static
wireless network setting, you must contact the network
administrator to get the static IP address.
* For the DHCP method
If the IP address assignment method is DHCP, check if
DHCP is shown in the Wireless Network Setting Confirm
window. However, if it shows Static, click Change TCP/IP
to change the assignment method to Receive IP address
automatically (DHCP).
* For the Static method
If the IP address assignment method is Static, check if
Static is shown in the Wireless Network Setting Confirm
window. However, if it shows DHCP, click Change TCP/IP
to enter the IP address and other network configuration
values for the machine.
Example)
If computer’s network information is as below:
- IP address: 169.254.133.42
- Subnet Mask: 255.255.0.0
Machine’s network information should be as below:
- IP address: 169.254.133. 43 (Use computer’s IP
address, with changed last three digits.)
- Subnet Mask: 255.255.0.0 (Use the computer’s subnet
mask.)
- Gateway: 169.254.133.1 (Change the last three digits
from IP address of your machine to 1.)
9. When the wireless network setting is completed, disconnect the USB
cable between the computer and machine. Click Next.

(g If the Change PC Network Setting window appears, follow
the steps on the window.
Click Next if you are finished the computer’s wireless network
settings.

If you set the computer’s wireless network as DHCP, it will take
several minutes to receive the IP address.

10. The Wireless Network Setting Complete window appears.
Select Yes if you accept the current settings and continue the setup
procedure.
Select No if you want to return to the beginning screen.
Then, click Next.
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11. Click Next when the Confirm Printer Connection window appears.

12. Select the components to be installed. Click Next.

After selecting the components, you can also change the machine
name, set the machine to be shared on the network, set the machine
as the default machine, and change the port name of each machine.
Click Next.

13. After the installation is finished, a window asking you to print a test
page appears. If you want to print a test page, click Print a test
page.

Otherwise, just click Next and go to step 15.

14. If the test page prints out correctly, click Yes.
If not, click No to reprint it.

15. To register as a user of the machine in order to receive information
from Samsung, click On-line Registration.

16. Click Finish.

Installing the machine on a wireless network with an
access point (Macintosh)

Items to prepare

Ensure you have next items ready.

» Access point

» Network-connected computer

» Software CD that provided with your machine

* The machine installed with a wireless network interface
» USB cable

Creating the infrastructure network in Macintosh
When the items are ready, follow below steps:

1. Check whether the USB cable is connected to the machine.
Turn on your computer, access point and machine.

Insert the supplied software CD into your CD-ROM drive.

Double-click the CD-ROM icon that appears on your Macintosh
desktop.

Double-click the MAC_Installer folder.

Double-click the Installer OS X icon.

Enter the password and click OK.

The Samsung Installer window opens. Click Continue.

9. Read the license agreement and click Continue.

10. Click Agree to agree to the license agreement.

11. The Samsung Installer window opens. Click Continue.

12. Select Easy Install and click Install. Easy Install is recommended
for most users. All compoenets necessary for machine operations
will be installed.

If you select Custom Install, you can choose individual operations
will be installed.

13. Select the Wireless Setting and Installation option.

14. The software searches the wireless network.

'g If the searching has failed, you may check if the USB cable is

connected between the computer and machine properly, and
follow the instruction on the window.

PODN
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15. After searching, the window shows the wireless network devices.
Select the name (SSID) of access point you are using and click
Next.

When you set the wireless configuration manually, click
Advanced Setting.

« Enter the wireless Network Name: Type the SSID of
access point you want (SSID is case-sensitive).

* Operation Mode: Select Infrastructure.

* Authentication: Select an authentication type.
Open System: Authentication is not used, and encryption
may or may not be used, depending on the need for data
security.
Shared Key: Authentication is used. A device that has a
proper WEP key can access the network.
WPA Personal or WPA2 Personal: Select this option to
authenticate the print server based on WPA Pre-Shared
Key. This uses a shared secret key (generally called Pre
Shared Key pass phrase) which is manually configured on
the access point and each of its clients.

« Encryption: Select the encryption. (None, WEP64,
WEP128, TKIP, AES, TKIP AES)

« Network Key: Enter the encryption network key value.

« Confirm Network Key: Confirm the encryption network
key value.

*  WEP Key Index: If you are using the WEP Encryption,
select the appropriate WEP Key Index.

@ The wireless network security window does appear when the
access point has security setting.
The wireless network security window appears. The window
may differ according to its security mode, WEP or WPA.
* In case of WEP
Select Open System or Shared Key for the authentication
and enter WEP security key. Click Next.
WEP (Wired Equivalent Privacy) is a security protocol
preventing unauthorized access to your wireless network.
WEP encrypts the data portion of each packet exchanged
on a wireless network using a 64-bit or 128-bit WEP
encryption key.
* In case of WPA
Enter the WPA shared key and click Next.
WPA authorizes and identifies users based on a secret key
that changes automatically at regular intervals. WPA also
uses TKIP (Temporal Key Integrity Protocol) and AES
(Advanced Encryption Standard) for data encryption.
16. The window shows the wireless network setting and check if settings
are right. Click Next.
* For the DHCP method
If the IP address assignment method is DHCP, check if DHCP is
shown in the window. However, if it shows Static, click Change
TCPIIP to change the assignment method to DHCP.
* For the Static method
If the IP address assignment method is Static, check if Static is
shown in the window. However, if it shows DHCP, click Change
TCPI/IP to enter the IP address and other network configuration
values for the machine. Before entering the IP address for the
machine, you must know the computer’s network configuration
information. If the computer is set to DHCP, you must contact the
network administrator to get the static IP address.
Example)
If computer’s network information is as below:
- IP address: 169.254.133.42
- Subnet Mask: 255.255.0.0
Machine’s network information should be as below:
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- IP address: 169.254.133. 43 (Use computer’s IP address,
with changed last three digits.)

- Subnet Mask: 255.255.0.0 (Use the computer’s subnet
mask.)

- Gateway: 169.254.133.1 (Change the last three digits from IP
address of your machine to 1.)
17. The wireless network is connecting according to the network
configuration.
18. When the wireless network setting is completed, disconnect the USB
cable between the computer and machine.

19. After the installation is finished, click Quit.

Installing the machine on an Ad-Hoc wireless
network (Macintosh)

If you do not have a access point (AP), you may still connect the machine
wirelessly to your computer by setting up an Ad-Hoc wireless network by
following these simple directions.

Items to prepare

Ensure you have next items ready.

* Network-connected computer

» Software CD that provided with your machine

* The machine installed with a wireless network interface
* USB cable

Creating the Ad-Hoc network in Macintosh
When the items are ready, follow below steps:
1. Check whether the USB cable is connected to the machine.
Turn on your computer and machine.
Insert the supplied software CD into your CD-ROM drive.
Double-click the CD-ROM icon that appears on your Macintosh
desktop.
Double-click the MAC_Installer folder.
Double-click the Installer OS X icon.
Enter the password and click OK.
The Samsung Installer window opens. Click Continue.
Read the license agreement and click Continue.
. Click Agree to agree to the license agreement.
Select Easy Install and click Install. Easy Install is recommended
for most users. All compoenets necessary for machine operations
will be installed.
If you select Custom Install, you can choose individual operations
will be installed.

12. Click Wireless Setting and Installation.
13. The software searches the wireless network devices.

PODd
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(g If the searching has failed, you may check if the USB cable is
connected between the computer and machine properly, and
follow the instruction on the window.

14. After searching the wireless network, a list of wireless network your
machine has searched appears.
If you want to use the Samsung default ad-hoc setting, select the last
wireless network on the list, which Network Name(SSID) is
airportthru and Signal is Printer Self Network.
Then, click Next.
If you want to use other ad-hoc settings, select other wireless
network from the list.

w If you want to change ad-hoc settings click the Advanced

Setting button.

« Enter the wireless Network Name: Type in the SSID
name you want (SSID is case-sensitive).

« Operation Mode: Select Ad-hoc.

* Channel: Select the channel. (Auto Setting or 2412 MHz
to 2467 MHz).

« Authentication: Select an authentication type.
Open System: Authentication is not used, and encryption
may or may not be used, depending on the need for data
security.
Shared Key: Authentication is used. A device that has a
proper WEP key can access the network.

* Encryption: Select the encryption. (None, WEP64,
WEP128)

* Network Key: Enter the encryption network key value.

« Confirm Network Key: Confirm the encryption network
key value.

«  WEP Key Index: If you are using the WEP Encryption,
select the appropriate WEP Key Index.

fg The wireless network security window appears when the

ad-hoc network has security setting.

The wireless network security window appears. Select Open

System or Shared Key for the authentication and click Next.

«  WEP (Wired Equivalent Privacy) is a security protocol
preventing unauthorized access to your wireless network.
WEP encrypts the data portion of each packet exchanged
on a wireless network using a 64-bit or 128-bit WEP
encryption key.

15. The window which shows the wireless network setting appears.
Check the settings and click Next.

Before entering the IP address for the machine, you must know
the computer’s network configuration information. If the
computer’s network configuration is set to DHCP, the wireless
network setting should also be DHCP. Likewise, if the
computer’s network configuration is set to Static, the wireless
network setting should also be Static.

If your computer is set to DHCP and you want to use Static
wireless network setting, you must contact the network
administrator to get the static IP address.
*  For the DHCP method
If the IP address assignment method is DHCP, check if
DHCP is shown in the Wireless Network Setting Confirm
window. However, if it shows Static, click Change TCP/IP
to change the assignment method to Receive IP address
automatically (DHCP).
* For the Static method
If the IP address assignment method is Static, check if
Static is shown in the Wireless Network Setting Confirm
window. However, if it shows DHCP, click Change TCP/IP
to enter the IP address and other network configuration
values for the machine.
Example)
If computer’s network information is as below:
- IP address: 169.254.133.42
- Subnet Mask: 255.255.0.0
Machine’s network information should be as below:
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- IP address: 169.254.133. 43 (Use computer’s IP
address, with changed last three digits.)

- Subnet Mask: 255.255.0.0 (Use the computer’s subnet
mask.)

- Gateway: 169.254.133.1 (Change the last three digits
from IP address of your machine to 1.)

16. The wireless network is connecting according to the network
configuration.

17. When the wireless network setting is completed, disconnect the USB
cable between the computer and machine.

18. After the installation is finished, click Quit.

SETTING A WIRELESS NETWORK WITH
NETWORK CABLE

Your machine is a network compatible machine. To enable your machine to
work with your network you will need to perform some configuration
procedures.

w Refer to your network administrator, or the person that set up your
wireless network, for information about your network configuration.

Preparing items

Ensure you have next items ready.

« Access point

« Network-connected computer

« Software CD that provided with your machine

« The machine installed with a wireless network interface
* Network cable

Setting IP address

Firstly, you have to set up an IP address for network printing and

managements. In most cases a new IP address will be automatically

assigned by a DHCP (Dynamic Host Configuration Protocol) server located
on the network.

In a few situations the IP address must be set manually. This is called a

static IP and is often required in corporate Intranets for security reasons.

« DHCP IP assignment: Connect your machine to the network, and wait a
few minutes for the DHCP server to assign an IP address to the
machine. Then, print the Network Configuration Report as explained
above. If the report shows that the IP address has changed, the
assignment was successful. You will see the new IP address in the
report (See "How to print a network configuration report" on page 37).

« Static IP assignment: Use SetIP program to change the IP address
from your computer.

In an office environment, we recommend that you contact a network

administrator to set this address for you.

IP setting using SetIlP Program (Windows)

This program is for manually setting the network IP address of your
machine using its MAC address to communicate with the machine. A
MAC address is the hardware serial number of the network interface and
can be found in the Network Configuration Report.

For using SetIP program, disable the computer firewall before continuing
by performing the following:

1. Open Start > All programs > Control Panel.
2. Double click Security Center.

3. Click Windows Firewall.

4. Disable the firewall.

Installing the program

1. Insert the Printer Software CD-ROM provided with your machine.
When the driver CD runs automatically, close that window.

Start Windows Explorer and open the X drive. (X represents your
CD-ROM drive.)

Double-click Application > SetIP.

Double-click Setup.exe to install this program.

Click OK. If necessary, select a language from the drop-down list.
Follow the instructions in the window and complete the installation.

N
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Starting the program
1. Connect your machine to the network with a network cable.
2. Turned on the machine.

3. From the Windows Start menu, select All Programs > Samsung
Printers > SetIP > SetIP.

4. Click on the £t icon (third from left) in the SetlP window to open the
TCP/IP configuration window.

5. Enter the machine’s new information into the configuration window
as follows. In a corporate intranet, you may need to have this
information assigned by a network manager before proceeding.

TCP/IP Configuration X
TCP/P }
Mac Address : |
IP Addrass | —
Subnet Mask : [ N A K
Default Gateway : [ . . R
Apply Cancel Reset

* MAC Address: Find the machine’s MAC address from the
Network Configuration Report and enter it without the colons.
For example, 00:15:99:29:51:A8 becomes 0015992951A8.

« IP Address: Enter a new IP address for your printer.

For example, if your computer’s IP address is 192.168.1.150,
enter 192.168.1.X. (X is number between 1 and 254 other than
the computer’s address.)

* Subnet Mask: Enter a Subnet Mask.
* Default Gateway: Enter a Default Gateway.

6. Click Apply, and then click OK. The machine will automatically print
the Network Configuration Report. Confirm that all the settings are
correct.

7. Click Exit to close the SetIP program.
8. If necessary, restart the computer’s firewall.

IP setting using SetIlP Program (Macintosh)

For using SetlIP program, disable the computer firewall before continuing

by performing the following:

',g The path and Uls may differ by Mac OS version. Refer to the Mac
OS manual.

1. Open System Preferences.

2. Click Security.
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3. Click the Firewall menu.
4. Turn firewall off.

',g The following instructions may vary for your model.

1. Connect your machine to the network with a network cable.

2. Insert the Installation CD-ROM, and open the disk window, select
MAC_Installer > MAC_Printer > SetIP > SetIPApplet.html.

3. Double click the file and Safari will automatically open, then select
Trust. The browser will open the SetlPApplet.html page that shows
the printer’'s name and IP address information.

4. Click on the £t icon (third from left) in the SetIP window to open the
TCP/IP configuration window.

5. Enter the machine’s new information into the configuration window
as follows. In a corporate intranet, you may need to have this
information assigned by a network manager before proceeding.

* MAC Address: Find the machine’s MAC address from the
Network Configuration Report and enter it without the colons.
For example, 00:15:99:29:51:A8 becomes 0015992951A8.

« IP Address: Enter a new IP address for your printer.

For example, if your computer’s IP address is 192.168.1.150,
enter 192.168.1.X. (X is number between 1 and 254 other than
the computer’s address.)

* Subnet Mask: Enter a Subnet Mask.

« Default Gateway: Enter a Default Gateway.

6. Select Apply, then OK, and OK again. The printer will automatically
print the configuration report. Confirm that all the settings are correct.
Quit Safari. You may close and eject the installation CD-ROM. If
necessary, restart the computer’s firewall. You have successfully
changed the IP address, subnet mask, and gateway.

Configuring the machine’s wireless network

Before starting you will need to know the network name(SSID) of your
wireless network and the network key if it is encrypted. This information was
set when the access point (or wireless router) was installed. If you do not
know about your wireless environment, please ask the person who has set
up your network.

To configure wireless parameters, you can use SyncThru™ Web Service.

Using SyncThru™ Web Service

Before starting wireless parameter configuration, make sure cable

connection status.

1. Check whether the network cable is connected to the machine. If not,
connect the machine with a standard network cable.

2. Start a web browser such as Internet Explorer, Safari or Firefox and
enter your machine’s new IP address in the browser window.

For example,

&) hitp1//192. 166,113/

3. Click Login on the upper right of the SyncThru™ Web Service
website.
A log-in page appears.

4. Type in the ID and Password then click Login.
If it's your first time logging into SyncThru™ Web Service, type in the
below default ID and password.
* ID: admin
* Password: sec00000

5. When the SyncThru™ Web Service window opens, click Network
Settings.

6. Click Wireless > Wizard.

Wizard will help you setup the wireless network configuration.
However, if you want to set the wireless network directly, select
Custom.

7. Select the one Network Name(SSID) in the list.

» SSID: SSID (Service Set Identifier) is a name that identifies a
wireless network. access points and wireless devices attempting
to connect to a specific wireless network must use the same
SSID. The SSID is case-sensitive.

« Operation Mode: Operation Mode refers to the type of wireless
connections (See "Wireless network name and network key" on
page 38).

- Ad-hoc: Allows wireless devices to communicate directly with
each other in a peer-to-peer environment.

- Infrastructure: Allows wireless devices to communicate with
each other through an access point.

',g If your network’s Operation Mode is Infrastructure, select the
SSID of the access point. If the Operation Mode is Ad-hoc,
select the machine’s SSID. Note that “airportthru” is the default
SSID of your machine.

8. Click Next.
If wireless security setting window appears, enter the registered
password (network key) and click Next.

9. The confirmation window appears, please check your wireless setup.
If the setup is right, click Apply.

Disconnect the network cable (standard or network). Your
machine should then start communicating wirelessly with the
network. In case of Ad-hoc mode, you can use a wireless LAN
and wired LAN simultaneously.

COMPLETING THE INSTALLATION

After you have installed your Samsung wireless network printer, print
another copy of the Network Configuration Report and keep it for future
reference. You are now ready to use your new Samsung wireless printer on
your network.

@ If the wireless network seems to not be working, set all the network
setting to the factory defaults and try again (See "Restoring factory
default settings using SyncThru™ Web Service" on page 33).

TROUBLESHOOTING

Solving problems that might occur during wireless
setting and installing the machine driver

Printers Not Found
* Your machine may not be turned on. Turn on your computer and the
machine.

» USB cable is not connected between your computer and machine.
Connect machine to your computer using the USB cable.

» The machine does not support wireless network. Check the
machine's user's guide included on the software CD supplied with
your machine and prepare a wireless network machine.

Connecting Failure - Not found SSID

* The machine is unable to search network name (SSID) which you
have selected or typed in. Check the network name (SSID) on your
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access point and try connecting again.
*  Your access point is not turned on. Turn on your access point.

Connecting Failure - Invalid Security

* You configured security incorrectly. Check the configured security on
your access point and machine.

Connecting Failure - General Connection Error

* Your computer is not receiving a signal form your machine. Check
the USB cable and your machine power.

Connecting Failure - Connected Wired Network

* Your machine is connected with wired network cable. Remove the
wired network cable from your machine.

PC Connection Error

» The configured network address is unable to connect between your
computer and machine.
- For DHCP network environment

The print receives the IP address automatically (DHCP) when
computer is configured to DHCP.

- For Static network environment

The machine uses the static address when computer is
configured to static address.

If you computer has following addresses,

- IP address: 192.168.1.100

- Subnet address: 255.255.255.0

- Gateway address: 192.168.1.1

Type in the following address for your machine,
- |P address: 192.168.1.101

- Subnet address: 255.255.255.0

- Gateway address: 192.168.1.1

Solving other problems

If problems occur while using the machine on a network, check the
followings.

',g For information on access point (or wireless router), refer to its own
user's guide.

* Your computer, access point or machine may not be turned on.

« Check the wireless reception around the machine. If the reception is far
from the machine or there is an obstacle, you might have difficulty
receiving the signal.

« Cycle the power for access point (or wireless router), machine and
computer. Sometimes cycling the power can recover network
communication.

« Check whether firewall software (V3 or Norton) is blocking the
communication.

If the computer and the machine is connected on a same network it
cannot be searched, firewall software might be blocking the
communication. Refer to the user's guide for the software to turn it off
and try searching the machine again.

* Check whether the machine's IP address is allocated correctly. You can
check the IP address by printing the network configuration report.

* Check whether access point (or wireless router) has a configured
security (password). If it has a password, refer to the access point (or
wireless router) administrator.

« Check whether the machine's IP address. Reinstall the machine driver
and change the settings to connect to the machine on the network. Due

to the characteristics of DHCP, the allocated IP address could change if
the machine is not used for a long time or if the access point has been
reset.

Check the wireless environment. You might not be able to connect to the
network in the infrastructure environment where you need to type in a
user's information before connecting to access point (or wireless router).
This machine only supports IEEE 802.11 b/g/n and Wi-Fi. Other wireless
communication (Bluetooth) is not supported.

When using the Ad-hoc mode, for operating systems such as Windows
Vista, you might need to set the wireless connection setting every time
you use the wireless machine.

You cannot use infrastructure mode and Ad-hoc mode at the same time
for Samsung wireless network machine.

The machine is within the range of the wireless network.

For most networks, the machine should be within 30 meters (100 feet) of
the wireless access point (or wireless router).

The machine is located away from obstacles that could block the
wireless signal.

Remove any large metal objects between the access point (or wireless
router) and the machine.

Make sure the machine and wireless access point (or wireless router)
are not separated by poles, walls, or support columns containing metal
or concrete.

The machine is located away from other electronic devices that may
interfere with the wireless signal.

Many devices can interfere with the wireless signal, including baby
monitors, motors, cordless phones, security system cameras, other
wireless networks, and some Bluetooth devices.
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pasic setup

After installation is complete, you may want to set the machine’s default settings. Refer to the next section if you would like
to set or change values. This chapter gives you step-by-step instructions for setting up the machine.

This chapter includes:

« Altitude adjustment
« Setting the default tray and paper

ALTITUDE ADJUSTMENT

The print quality is affected by atmospheric pressure, which is determined
by the height of the machine above sea level. The following information will
guide you on how to set your machine to the best print quality or best quality
of print.

Before you set the altitude value, determine the altitude where you are.

1 High1
2 High 2
3 High 3
4 Normal

You can altitude adjustment in Printer Settings Utility.

1. Double-click the Smart Panel icon on the Windows task bar (or
Notification Area in Linux). You can also click Smart Panel on the status
bar in Mac OS X (See "Using the Smart Panel program" on page 66).
Or, if you are a Windows user, you can launch it from the Start menu,
select Programs or All Programs > Samsung Printers > your printer
driver name > Smart Panel.

2. Click Printer Setting.

Select necessary options in the Altitude Adjustment drop-down list.

4. Click the Apply button.

If your machine is connected to a network, SyncThru™ Web Service
screen appears automatically. This can also be adjusted via SyncThru™
Web Service.

ad

SETTING THE DEFAULT TRAY AND PAPER

You can select the tray and paper you would like to keep using for printing
job.

» Using the power saving feature
» Changing font setting (CLP-320N(K)/CLP-321N/CLP-325W(K) only)

From your computer

Windows
1. Click the Windows Start menu.
2. For Windows 2000, select Settings > Printers.
« For Windows XP/Server 2003, select Printers and Faxes.

« For Windows Server 2008/Vista, select Control Panel >
Hardware and Sound > Printers.

* For Windows 7, select Control Panel > Devices and Printers.

* For Windows Server 2008 R2, select Control Panel > Hardware
> Devices and Printers.

3. Right-click on your machine.

4. For Windows Server 2003/Server 2008/XP/Vista, press Printing
Preferences.
For Windows 7/Server 2008 R2, from context menus, select the
Printing Preferences.

[g If Printing Preferences item has a » mark, you can select
other printer drivers connected with the selected printer.

Click Paper tab.

Select options such as number of copies, paper size or paper type.
Press OK.

',g If you want to use special-sized paper such as a billing paper,

select Edit... in the Paper tab in the Printing Preferences (See
"Opening printing preferences" on page 57).

No o

Macintosh

Macintosh does not support this function. Macintosh users need to
change the default setting manually each time they want to print using
other settings.

Open a Macintosh application and select the file you want to print.
Open the File menu and click Print.

Go to Paper Feed pane.

Set appropriate tray from which you want to print.

Go to Paper pane.

Set paper type to correspond to the paper loaded in the tray from
which you want to print.

7. Click Print to print.

o0 RN =

USING THE POWER SAVING FEATURE

When you will not be using the machine for a while, you can use this feature
to save power.

You change power save in Printer Settings Utility.
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1. Double-click the Smart Panel icon on the Windows task bar (or
Notification Area in Linux). You can also click Smart Panel on the status
bar in Mac OS X (See "Using the Smart Panel program" on page 66).

Or, if you are a Windows user, you can launch it from the Start menu,
select Programs or All Programs > Samsung Printers > your printer
driver name > Smart Panel.

2. Click Printer Setting.

3. Click Setting > Power Save. Select the appropriate value from the
drop-down list, and then click Apply.

CHANGING FONT SETTING
(CLP-320N(K)/CLP-321N/CLP-325W(K) ONLY)

Your machine has preset font setting depending on your region or country.
If you want to change the font or set the font for special condition, such as
the DOS environment, you can change the font setting as follows:

1. Double-click the Smart Panel icon on the Windows task bar (or
Notification Area in Linux). You can also click Smart Panel on the status
bar in Mac OS X (See "Using the Smart Panel program" on page 66).
Or, if you are a Windows user, you can launch it from the Start menu,
select Programs or All Programs > Samsung Printers > your printer
driver name > Smart Panel.

Click Printer Setting.

Click Emulation.

Confirm if PCL is selected in Emulation Setting.

Click Setting.

Select your preferred font in the Symbol set list.

Click Apply.

'g Following information shows the proper font list for corresponding
languages.

* Russian: CP866, ISO 8859/5 Latin Cyrillic

* Greek: 1SO 8859/7 Latin Greek, PC-8 Latin/Greek

* Arabic & Farsi: HP Arabic-8, Windows Arabic, Code Page 864,
Farsi, ISO 8859/6 Latin Arabic

No oD
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media and tray

This chapter introduces you how to load originals and print media into your machine.

This chapter includes:

« Selecting print media
« Changing the tray size
« Loading paper in the tray

SELECTING PRINT MEDIA

You can print on a variety of print media, such as plain paper, envelopes,
labels, and transparencies. Always use print media that meets the
guidelines for use with your machine and from the appropriate tray.

Guidelines for selecting the print media

Print media that does not meet the guidelines outlined in this user’s guide

may cause the following problems:

« Poor print quality

« Increased paper jams

« Premature wear on the machine.

« Permanent fuser damage, not covered under warranty.

Properties, such as weight, composition, grain, and moisture content, are

important factors that affect the machine’s performance and the output

quality. When you choose print materials, consider the following:

« The type, size and weight of the print media for your machine are
described later in this section.

« Desired outcome: The print media you choose should be appropriate for
your project.

* Brightness: Some print media are whiter than others and produce
sharper, more vibrant images.

« Surface smoothness: The smoothness of the print media affects how
crisp the printing looks on the paper.

w .

Some print media may meet all of the guidelines in this section and
still not produce satisfactory results. This may be the result of the
sheets characteristics, improper handling, unacceptable
temperature and humidity levels, or other variables over which
cannot be controlled.

» Before purchasing large quantities of print media, ensure that it
meets the required specifications in this user’s guide and meets
your output requirements.

Using print media that does not meet these specifications may
cause problems or require repairs. Such repairs are not covered
by Samsung’s warranty or service agreements.

* Make sure not to use the inkjet photo paper with this machine. It
could cause damage to the machine.

» Printing on special media
» Setting the paper size and type
* Adjusting the output support

Media sizes supported in each mode

MODE SIZE TYPE SOURCE
Simplex For details about For details about Tray
printing paper size, see paper type, see

"Print media "Print media
specifications" on specifications" on
page 89. page 89.
Duplex Letter, Legal, Oficio, | Plain, Thick, Tray
printing US Folio, A4, ISO Cotton, Color,
(Manual)® | B5, JISBS5, Preprinted,
Executive, A5, A6 Recycled,

CardStock, Archive

a.75 to 90 g/m? (20-24 Ibs bond) only
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CHANGING THE TRAY SIZE

To load different sizes of paper, such as Legal-sized paper, you need to
adjust the paper guides to extend the paper tray.

To change the tray size to other size, you must adjust the paper
length/width guides properly.

1 Paper extend lever

2 Paper cover

3 Paper length guide

4 Paper width guide

1. Pull the tray out of the machine. Open the paper cover and remove
paper from the tray if necessary.

2. Pressing and unlatching the guide lock in the tray, pull the tray out
manually.

4. Slide the paper length guide until it lightly touches the end of the paper
stack. Squeeze the paper width guide and slide it to the edge of the
paper stack without causing it to bend.

For paper smaller than Letter-sized, return the paper guides to their
original positions and adjust the paper length guide and paper width
guide.

If the paper that you need to print is shorter than length 222 mm (8.74
inches), press and unlatch the guide lock in the tray, push the tray in
manually. Adjust the paper length guide and paper width guide.

w * Do not push the paper width guides far enough to cause the
materials to warp.

» If you do not adjust the paper width guides, it may cause paper
jams.

o

=i

=

Media and tray_ 49



» Do not use a paper with more than 6 mm (0.24 inch.) curl.

6. Slide the tray back into the machine until it clicks.
7. Set the paper type and size for the tray ("Setting the paper size and
type" on page 54).

',g If you experience problems with paper feeding, check whether the
paper meets the media specifications. Then, try placing one sheet
at a time in tray (See "Print media specifications" on page 89 or
see "Printing on special media" on page 52).

The tray is preset to Letter or A4 size, depending on your country. To

change the size to A4 or Letter, you must adjust the lever and paper width

guide properly.

1. Pull the tray out of the machine. Open the paper cover and remove
paper from the tray if necessary.

2. If you want to change the size to Letter, hold the lever at the back of the
tray, and rotate the lever clockwise.

3. Squeeze the paper width guide and slide it to the edge of the lever.

',g If you want to change the size to A4, first move the paper width
guide to left and rotate the lever counterclockwise. If you force the
lever, it could damage the tray.

LOADING PAPER IN THE TRAY

In the tray

1. Pull out the paper tray. Adjust the tray size to the media size you are
loading (See "Changing the tray size" on page 49).

2. Flex or fan the edge of the paper stack to separate the pages before
loading the paper.

3. Place the paper with the side you want to print facing up.

4. Squeeze the tray paper guides and adjust them to the width and length
of the paper. Do not force them too much or the paper will be bent result
in a paper jam or skew.

5. Close the paper cover.
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6. Insert the tray back into the machine.

To print in application, open an application and start the print menu.

8. Open Printing Preferences (See "Opening printing preferences" on
page 57).

9. Press the Paper tab in Printing Preferences and select an appropriate
paper type, size and source.

10. Press OK.

11. Start printing in application.

N

w If you experience problems with paper feeding, check whether the
paper meets the media specification. Then, try placing one sheet
at a time in the tray (See "Print media specifications" on page 89).

The tray is preset to Letter or A4 size, depending on your country. To

change the size to A4 or Letter, you must adjust the lever and paper width

guide properly.

1. Pull the tray out of the machine. Open the paper cover and remove
paper from the tray if necessary.

2. If you want to change the size to Letter, hold the lever at the back of the
tray, and rotate the lever clockwise.

3. Squeeze the paper width guide and slide it to the edge of the lever.

w If you want to change the size to A4, first move the paper width
guide to left and rotate the lever counterclockwise. If you force the
lever, it could damage the tray.

Manual feeding in the tray

To load different sizes of paper such as envelope, transparency, labels or
custom-sized paper, you need to adjust the paper guides for manual
feeding in the tray.

To use manual feeding in the tray, you must adjust the paper length/width
guide properly.
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Tips on using the manual feeding method
Tips on manual feeding in the tray

If you select Manual Feeder for Source from your software
application, you need to press (cancel button) each time you print
a page. Load only one type, size and weight of print media at a time
in the tray.

To prevent paper jams, do not add media while printing. This also
applies to other types of print media.

Print media should be loaded face up with the top edge going into
the tray first and be placed in the center of the tray.

Always load the use recommended print media only to avoid paper
jams and print quality problems (See "Print media specifications" on
page 89).

Flatten any curl on postcards, envelopes and labels before loading
them into the tray.

. Pull the tray out of the machine. Open the paper cover and remove
paper from the tray if necessary.

3. Squeeze the tray paper width guided and adjust them to the width of

the paper until it lightly touches the end of the paper stack. Do not
force too much, or the paper will bend resulting in a paper jam or
skew.

For paper smaller than Letter-sized, return the paper guides to their
original positions and adjust the paper length guide and paper width



guide. 9. Select Manual Feeder in paper source, then press OK.
10. Start printing in application.

"ﬁ If you are printing multiple pages, load the next sheet after the first

page prints out, and press the ©) (cancel button). Repeat this step
for every page to be printed.

PRINTING ON SPECIAL MEDIA

The table below shows the available special media for each tray.

If the paper that you need to print is shorter than length 222 mm

(8.74 inches), press and unlatch the guide lock in the tray, push the When using special media, we recommend you feed one paper at a
tray in manually. Adjust the paper length guide and paper width time. Check the maximum input number of media for each tray (See
guide. "Print media specifications" on page 89).
Plain . °
Thick ° .
Thin ° °
Cotton ° °
Color ° °
Preprinted ° °
Recycled ° °
(Z) * Do not push the paper width guides far enough to cause Envelope °
the materials to warp. Transparency °
» If you do not adjust the paper width guides, it may cause Labels °
paper jams. CardStock °
Bond °
o /\ Archive °
= ==ali = Glossy Photo °
Matte Photo °
+ Do not use a paper with more than 6 mm (0.24 inch.) curl. ( e: Supported, Blank: Not supported)

The following media types are shown in the Printing Preferences. This
paper type option allows you to set the type of paper to be loaded in the
tray. Selecting the appropriate media will let you get the best printout
quality. Selecting inappropriate media can result in poor print quality.

* Plain: Normal plain paper. Select this type if your printing on 60 to 90
g/m? (16 to 24 Ibs).

+  Thick: 90 to 163 g/m? (24 to 43 Ibs) thick paper.

+ Thin: 60 to 70 g/m? (16 to 19 Ibs) thin paper.

+ Cotton: 75 to 90 g/m? (20 to 24 Ibs) cotton paper.

+ Color: 75 to 90 g/m? (20 to 24 Ibs) color-backgrounded paper.

+  Preprinted: 75 to 90 g/m? (20 to 24 Ibs) preprinted/letterhead paper.

+ Recycled: 60 to 90 g/m? (16 to 24 Ibs) recycled paper.

When you use recycled paper, printouts might be wrinkled and/or
jamming may occur due to excessive curl.

+ Envelope: 75 to 90 g/m? (20 to 24 Ibs) envelope.

* Transparency: 0.104 to 0.124 mm (0.004094 to 0.004882 inches)
transparency paper.

+ Labels: 120 to 150 g/m? (32 to 40 Ibs) label.

+ CardStock: 105 to 163 g/m? (28 to 43 Ibs) cardstock.

+ Bond: 105 to 120 g/m? (28 to 32 Ibs) bond.

+ Archive: 70 to 90 g/m? (19 to 24 Ibs). If you need to keep the print-out
for a long time, such as for archives.

. Slide the tray back into the machine until it clicks.

. To print in application, open an application and start the print menu.
. Open Printing Preferences (See "Opening printing preferences" on
page 57).

. Press the Paper tab in Printing Preferences, and select an
appropriate paper type.

(g For example, if you want to use a label, set the paper type to
Label.
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+  Glossy Photo: 111 to 220 g/m? (30 to 58 Ibs bond) glossy photo paper.
+  Matte Photo: 111 to 220 g/m? (30 to 58 Ibs bond) matte photo paper.

Envelopes

Successful printing on envelopes depends upon the quality of the
envelopes.

To print an envelope, place it flap side down with the stamp area on the top
left side.

«  When selecting envelopes, consider the following factors:
- Weight: The weight of the envelope paper should not exceed
90 g/m? otherwise, jams may occur.
- Construction: Prior to printing, envelopes should lie flat with less
than 6 mm (0.24 inch.) curl, and should not contain air.

- Condition: Envelopes should not be wrinkled, nicked, either
damaged.

- Temperature: Use envelopes that are compatible with the heat and
pressure of the machine during operation.

« Use only well-constructed envelopes with sharp-and well-creased folds.
« Do not use stamped envelopes.

« Do not use envelopes with clasps, snaps, windows, coated lining,
self-adhesive seals, or other synthetic materials.

* Do not use damaged or poorly made envelopes.

« Be sure the seam at both ends of the envelope extends all the way to
the corner of the envelope.

(0 —' (2)
1 Acceptable

2 Unacceptable

* Envelopes with a peel-off adhesive strip or with more than one flap that
folds over to seal must use adhesives compatible with the machine’s
fusing temperature about 170°C (338 °F) for 0.1 second. The extra flaps
and strips might cause wrinkling, creasing, or jams and may even
damage the fuser.

« For the best print quality, position margins no closer than 15 mm (0.59
inch.) from the edges of the envelope.

« Avoid printing over the area where the envelope’s seams meet.

Transparencies

To avoid damaging the machine, use only transparencies designed for laser
printers.

« Transparencies used in the machine must be able to withstand
machine’s fusing temperature.

* Place them on a flat surface after removing them from the machine.

* Do not leave unused transparencies in the paper tray for long periods of
time. Dust and dirt may accumulate on them, resulting in spotty printing.

* To avoid smudging caused by fingerprints, handle transparencies
carefully.

» To avoid fading, do not expose printed transparencies to prolonged
sunlight.

» Ensure that transparencies are not wrinkled, curled, or have any torn
edges.

« Do not use transparencies that separate from the backing sheet.

« To prevent transparencies from sticking to each other, do not let the
printed sheets stack up as they are begin printed out.

*«  Recommended media: Xerox 3R91331 (A4), Xerox 3R2780 (Letter)
Base type transparency (ex. Xerox 3R91331) results in better image and
paper handling quality than paper backed (ex. Xerox 3R3028) or
removable stripe (3R3108) ones.

& « Transparency with static electricity can cause image quality

problems.
« Depending on the selection or storage conditions of the
transparency, jam or image scratch might occur.

Labels

To avoid damaging the machine, use only labels designed for use in laser
machines.

* When selecting labels, consider the following factors:

- Adhesives: The adhesive material should be stable at your
machine’s fusing temperature (about 170°C (338 °F)).

- Arrangement: Only use labels with no exposed backing between
them. Labels can peel off sheets that have spaces between the
labels, causing serious jams.

- Curl: Prior to printing, labels must lie flat with no more than 13 mm
(0.51 inch.) of curl in any direction.

- Condition: Do not use labels with wrinkles, bubbles, or other
indications of separation.

* Make sure that there is no exposed adhesive material between labels.

Exposed areas can cause labels to peel off during printing, which can
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cause paper jams. Exposed adhesive can also cause damage to
machine components.

+ Do not run a sheet of labels through the machine more than once. The
adhesive backing is designed for only a single pass through the
machine.

* Do not use labels that are separating from the backing sheet or are
wrinkled, bubbled, or otherwise damaged.

Card stock/Custom-sized paper

* Do not print on media smaller than 76 mm (3.00 inches) wide or
152.4 mm (6.00 inches) long.

« Insoftware applications, set margins at least 6.4 mm (0.25 inches) away
from the edges of the material.

Letterhead/Preprinted paper

SINGLE-SIDED DOUBLE-SIDED

Face up Face down

« Letterhead/ Preprinted paper must be printed with heat-resistant ink that
will not melt, vaporize, or release hazardous emissions when subjected
to the machine’s fusing temperature for 0.1 second. Check your
machine’s specification to view the fusing temperature about 170°C (338
°F).

* Letterhead/ Preprinted paper ink must be non-flammable and should not
adversely affect machine rollers.

* Forms and letterhead should be sealed in a moisture-proof wrapping to
prevent changes during storage.

« Before you load letterhead/preprinted paper, verify that the ink on the
paper is dry. During the fusing process, wet ink can come off preprinted
paper, reducing print quality.

Recycled paper

When loading recycled paper, printed side should be facing up with an

uncurled edge at the front. If you experience problems with paper feed, turn

the paper around. Note that print quality is not guaranteed.

« Recycled paper must be printed with heat-resistant ink that will not melt,
vaporize or release hazardous emissions when subjected to the
machine’s fusing temperature for 0.1 second. Check your machine’s
specification to view the fusing temperature about 170°C(338 °F).

* Recycled paper ink must be non-flammable and should not adversely
affect machine rollers.

« Before you load recycled paper, verify that the ink on the paper is dry.

During the fusing process, wet ink can come off recycled paper,
reducing print quality.

Glossy photo

'g Load one paper in the tray at a time, glossy side facing up.

* Recommended media: Glossy paper (Letter) for this machine by HP
Brochure Paper (Product: Q6611A).

* Recommended media: Glossy paper (A4) for this machine by HP
Superior Paper 160 glossy (Product: Q6616A).

Matte photo
',g Load one paper in the tray at a time, side to be printed facing up.

SETTING THE PAPER SIZE AND TYPE

After loading paper in the paper tray, you need to set the paper size and
type using the printer driver. Follow these steps to make your changes
permanent.

w The following procedure is for Windows XP. For other Windows OS,
refer to the corresponding Windows User's Guide or online help.

Click the Start button on the computer screen.

Select Printers and Faxes.

Right-click on the printer icon and select Printing Preferences.
Click the Paper tab and change the setting on Paper Options.
Click OK.

gk oON =

ADJUSTING THE OUTPUT SUPPORT

The printed pages stack on the output tray, and the output support will help
the printed pages align.

\
N

1 Output support

',g If you continuously print many pages, the surface of the output tray
may become hot. Be careful not to touch the surface, and especially
keep children away from the surface.
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ornting

This chapter explains common printing tasks.

This chapter includes:

« Introducing useful software program
* Printer driver features

« Basic printing

« Opening printing preferences

« Using help

« Using special print features

',g The procedures in this chapter are mainly based on Windows XP.

INTRODUCING USEFUL SOFTWARE PROGRAM
Samsung AnyWeb Print

This tool helps you to screen-capture, preview, scrap and print the screen of
Windows Internet Explorer more easily, when you use the ordinary program.
Click Start > All programs > Samsung Printers > Samsung AnyWeb
Print > Download the latest version to link the website where the tool is
available for the download. This tool is available only for Windows operating
systems.

Samsung Easy Color Manager

This program helps users to adjust color as they like. You can adjust the
printout color as they see them on the monitor. The adjusted color can be
stored on the printer driver and applied to printouts. Click Start > All
programs > Samsung Printers > Samsung Easy Color Manager >
Download the latest version to link the website where the tool is available
for the download. This tool is available only for Windows and Macintosh
operating systems.
(http://solution.samsungprinter.com/personal/colormanager)

PRINTER DRIVER FEATURES

Your printer drivers support the following standard features:

« Paper orientation, size, source, and media type selection

*  Number of copies

In addition, you can use various special printing features. The following

table shows a general overview of features supported by your printer
drivers:

Some models or operating systems may not support some of the
feature(s) in the following table.

» Changing the default print settings

» Setting your machine as a default machine
* Printing to a file (PRN)

* Macintosh printing

* Linux printing

Printer driver

FEATURE WINDOWS
Print quality option °
Poster printing °
Multiple pages per sheet .
Booklet printing (manual) °
Fit to page printing °
Reduce and enlarge printing °
Watermark °
Overlay °
Double-sided printing (manual) °

( o: Supported, Blank: Not supported)

BASIC PRINTING

Your machine allows you to print from various Windows, Macintosh, or
Linux applications. The exact steps for printing a document may vary
depending on the application you use.

rg * Your Printing Preferences window that appears in this user’s
guide may differ depending on the machine in use. However, the
composition of the Printing Preferences window is similar. Check
the operating system(s) that are compatible with your machine.
Refer to the OS compatibility section of Printer Specifications (See
"System requirements" on page 25).

« When you select an option in Printing Preferences, you may see

a warning mark, & or . . An exclamation mark ( 1 ) means you
can select that certain option but it is not recommended, and (g3)

mark means you cannot select that option due to the machine’s
settings or environment.

The following procedure describes the general steps required for printing
from various Windows applications.
',g Macintosh basic printing, see "Macintosh printing" on page 62.

Linux basic printing, see "Linux printing" on page 63.
The following Printing Preferences window is for Notepad in Windows XP.
Your Printing Preferences window may differ, depending on your
operating system or the application you are using.
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1. Open the document you want to print.

2. Select Print from the File menu. The Print window appears.
3. Select your machine from the Select Printer list.

& Print r?

General

Select Piinter

Stalus:  Fieady [Pt to fie

Location:
G
Page Flange

@8 Number of copies: |1 &
[ | Collat —
—— = P

[ | [Concel J [0y ]

You can select the basic print settings including the number of copies
and the print range from the Print window.

’,ﬁ To take advantage of the printer features provided by your printer
driver, click Properties or Preferences in the application’s Print
window to change the print setting (See "Opening printing
preferences" on page 57).

4. To start the print job, click OK or Print in the Print window.

',g If you are using Windows Internet Explorer, the Samsung AnyWeb
Print too will save your time for screen-captured images or printing
the image. Click Start > All programs > Samsung Printers >
Samsung AnyWeb Print to link the website where the tool is
available for the download.

Canceling a print job
If the print job is waiting in a print queue or print spooler, cancel the job as
follows.
1. Click the Windows Start menu.
2. For Windows 2000, select Settings > Printers.
* For Windows XP/Server 2003, select Printers and Faxes.
* For Windows Server 2008/Vista, select Control Panel > Hardware
and Sound > Printers.
* For Windows 7, select Control Panel > Devices and Printers.
*  For Windows Server 2008 R2, select Control Panel > Hardware >
Devices and Printers.
3. For Windows 2000, XP, Server 2003, Vista and Server 2008,
double-click your machine.
For Windows 7 and Windows Server 2008 R2, right-click your printer
icon > context menus > See what’s printing.

w If See what’s printing item has a » mark, you can select other
printer drivers connected with selected printer.

4. From the Document menu, select Cancel.
w You can also access this window by simply double-clicking the

=

machine icon (@ ) in the Windows task bar.

You can also cancel the current job by pressing on the control
panel.

OPENING PRINTING PREFERENCES

You can preview the settings you selected on the upper right of the Printing
Preferences.

1. Open the document you want to print.

2. Select Print from the File menu. The Print window appears.
3. Select your machine from the Select Printer.

4. Click Properties or Preferences.

Bkt | Poper | draphics | advanced | Swrng

Crieekation
) Pertrsh

Olandscace

[CInstste 180 Degrees:
= Cibest

@ Mol

Croeait

Type Sgle Page Per Side -

Using a favorite setting

The Presets option, which is visible on each of the preferences tab except
for the Samsung tab, allows you to save the current preferences for future
use.

To save a Presets item:
1. Change the settings as needed on each tab.
2. Enter a name for the item in the Presets input box.

Presets

|AAA| v
Orientation: X
Quality: x

- Draft:
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3. Click Add. When you save Presets, all current driver settings are saved.

If you click Add, the Add button changes to the Update button. Select more
options and click Update, settings will be added to the Presets you made.

To use a saved setting, select it from the Presets drop-down list. The
machine is now set to print according to the setting you selected.

To delete saved settings, select it from the Presets drop-down list and click
Delete.

You can also restore the printer driver’s default settings by selecting Default
Preset from the Presets drop-down list.

USING HELP

Click the question mark on the upper-right corner of the window and click on
the topic you want to know about. Then a pop-up window appears with
information about that option's feature which is provided from the driver.

If you want to search information via a keyword, click the Samsung tab in
the Printing Preferences window, and enter a keyword in the input line of
the Help option. To get information about supplies, driver update or
registration and so on, click appropriate buttons.

USING SPECIAL PRINT FEATURES

Special print features include:

« "Printing multiple pages on one sheet of paper" on page 58.
* "Printing posters" on page 58.

« "Printing booklets (Manual)" on page 58.

« "Printing on both sides of the paper (Manual)" on page 59.

« "Change percentage of your document" on page 59.

« "Fitting your document to a selected paper size" on page 59.
« "Using watermarks" on page 59.

« "Using overlay" on page 60.

« "Graphics tab options" on page 61.

Printing multiple pages on one sheet of paper

You can select the number of pages to print on a single sheet of paper. To
print more than one page per sheet, the pages will be reduced in size and
arranged in the order you specify. You can print up to 16 pages on one
sheet.

1. To change the print settings from your software application, access

Printing Preferences (See "Opening printing preferences" on page 57).

2. Click the Basic tab, select Multiple Pages Per Side in the Type
drop-down list.

3. Select the number of pages you want to print per sheet (2, 4, 6, 9, or 16)
in the Pages per Side drop-down list.

4. Select the page order from the Page Order drop-down list, if necessary.

5. Check Print Page Border to print a border around each page on the
sheet.

6. Click the Paper tab, select the Size, Source and Type.
7. Click OK or Print until you exit the Print window.

Printing posters

This feature allows you to print a single-page document onto 4, 9 or 16
sheets of paper, for the purpose of pasting the sheets together to form one
poster-size document.

ald
[
® =y

— A 3x3
1. To change the print settings from your software application, access
Printing Preferences (See "Opening printing preferences" on page 57).
2. Click the Basic tab, select Poster Printing in the Type drop-down list.
3. Select the page layout you want.
Available layouts:
* Poster 2x2: Document will be enlarged and be divided into 4 pages.
» Poster 3x3: Document will be enlarged and be divided into 9 pages.
» Poster 4x4: Document will be enlarged and be divided into 16
pages.
4. Select the Poster Overlap value. Specify Poster Overlap in millimeters
or inches by selecting the radio button on the upper right of Basic tab to
make it easier to paste the sheets together.

<10 mm

10 mm

5. Click the Paper tab, select the Size, Source, and Type.
6. Click OK or Print until you exit the Print window.
7. You can complete the poster by pasting the sheets together.

Printing booklets (Manual)

This feature prints your document on both sides of a paper and arranges the
pages so that the paper can be folded in half after printing to produce a
booklet.

w If you want to make a booklet, you need to print on Letter, Legal, A4,
US Folio or Oficio sized print media.

1. To change the print settings from your software application, access the
Printing Preferences (See "Opening printing preferences" on page 57).

2. Click the Basic tab, select Booklet Printing from the Type drop-down
list.

3. Click the Paper tab, select the Size, Source, and Type.
"ﬁ The Booklet Printing option is not available for all paper sizes. In

order to find out the available paper size for this feature, select the
available paper size in the Size option on the Paper tab.

If you select an unavailable paper size, this option can be
automatically canceled. Select only available paper. (paper without
1 or & mark).
4. Click OK or Print until you exit the Print window.
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5. After printing, fold and staple the pages.

Printing on both sides of the paper (Manual)

You can print on both sides of a paper (duplex). Before printing, decide how

you want your document oriented. You can use this feature with Letter,

Legal, A4, US Folio or Oficio sized paper (See "Print media specifications"

on page 89).

We recommend not to print on both sides of special media, such as
labels, envelopes, or thick paper. It may cause a paper jam or damage
the machine.

1. To change the print settings from your software application, access

Printing Preferences (See "Opening printing preferences" on page 57).

2. Click the Advanced tab.

3. From the Double-Sided Printing (Manual) section, select the binding
option you want.

* None
+ Long Edge: This option is the conventional layout used in
bookbinding.

» Short Edge: This option is the conventional layout used in
calendars.

4. Click the Paper tab, select the Size, Source, and Type.
5. Click OK or Print until you exit the Print window.

w If your machine does not have a duplex unit, you should complete the
printing job manually. The machine prints every other page of the
document first. After that, a message appears on your computer.
Follow the on-screen instructions to complete the printing job.

Change percentage of your document

You can change the size of a document to appear larger or smaller on the
printed page by typing in a percentage you want.

gfd o

1. To change the print settings from your software application, access

Printing Preferences (See "Opening printing preferences" on page 57).

2. Click the Paper tab.
3. Enter the scaling rate in the Percentage input box.
You can also click the up/down arrows to select the scaling rate.
4. Select the Size, Source, and Type in Paper Options.
5. Click OK or Print until you exit the Print window.

Fitting your document to a selected paper size

This feature allows you to scale your print job to any selected paper size
regardless of the document size. This can be useful when you want to
check fine details on a small document.

f
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To change the print settings from your software application, access

1.
Printing Preferences (See "Opening printing preferences" on page 57).
2. Click the Paper tab.
3. Select the paper size you want from the Fit to Page.
4. Select the Size, Source and Type in Paper Options.

5. Click OK or Print until you exit the Print window.

Using watermarks

The watermark option allows you to print text over an existing document.
For example, you use it when you want to have large gray letters reading
“DRAFT” or “CONFIDENTIAL” printed diagonally across the first page or all
pages of a document.

Al>LA

There are several predefined watermarks that come with the machine. They
can be modified, or you can add new ones to the list.

Using an existing watermark

1. To change the print settings from your software application, access
Printing Preferences (See "Opening printing preferences" on
page 57).

2. Click the Advanced tab, and select the desired watermark from the
Watermark drop-down list. You will see the selected watermark in
the preview image.

3. Click OK or Print until you exit the print window.

Creating a watermark

1. To change the print settings from your software application, access
Printing Preferences (See "Opening printing preferences" on
page 57).

2. From the Advanced tab, select Edit from the Watermark drop-down
list. The Edit Watermarks window appears.

3. Enter a text message in the Watermark Message box. You can
enter up to 256 characters. The message displays in the preview
window.

When the First Page Only box is checked, the watermark prints on
the first page only.

4. Select watermark options.

You can select the font name, style, size, and shade from the Font
Attributes section, as well as set the angle of the watermark from
the Message Angle section.

5. Click Add to add a new watermark to the Current Watermarks list.

Printing_ 59



6. When you have finished, click OK or Print until you exit the Print
window.

To stop printing the watermark, select None from the Watermark

drop-down list.

Editing a watermark

1. To change the print settings from your software application, access
Printing Preferences (See "Opening printing preferences" on
page 57).

2. Click the Advanced tab, select Edit... from the Watermark
drop-down list. The Edit Watermarks window appears.

3. Select the watermark you want to edit from the Current Watermarks
list and change the watermark message and options.

4. Click Update to save the changes.

5. Click OK or Print until you exit the Print window.

Deleting a watermark

1. To change the print settings from your software application, access
Printing Preferences (See "Opening printing preferences" on
page 57).

2. Click the Advanced tab, select Edit... from the Watermark
drop-down list. The Edit Watermarks window appears.

3. Select the watermark you want to delete from the Current
Watermarks list and click Delete.

4. Click OK or Print until you exit the Print window.

Using overlay

An overlay is content you store on your hard disk drive that can be
superimposed over any document you print. An overlay is often used to take
the place of letterhead paper. Rather than using preprinted letterhead, you
can create an overlay containing exactly the same information that is
currently on your letterhead. To print a letter with your company’s
letterhead, you do not need to load preprinted letterhead paper in the
machine, instead you can just print the letterhead overlay on your
document.
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Creating a new page overlay
To use a page overlay, you must create a new page overlay file

8. Thefile is not printed. Instead, it is stored on your computer hard disk
drive.

The overlay document size must match same as the document
you print. Do not create an overlay with a watermark.

Using a page overlay

After an overlay has been created, it is ready to be printed with your

document. To print an overlay with a document:

1. Create or open the document you want to print.

2. To change the print settings from your software application, access
Printing Preferences (See "Opening printing preferences" on
page 57).

3. Click the Advanced tab.

Select the desired overlay from the Text drop-down list.

5. If the overlay file you want does not appear in the Text drop-down
list, select Edit... from the list and click Load. Select the overlay file
you want to use.

If you have stored the overlay file you want to use in an external
source, you can also load the file when you access the Open
window.

After you select the file, click Open. The file appears in the Overlay
List box and is available for printing. Select the overlay from the
Overlay List box.

6. If necessary, check Confirm Page Overlay When Printing box. If
this box is checked, a message window appears each time you
submit a document for printing, asking you to confirm that you wish
to print an overlay on your document.

If this box is not checked and an overlay has been selected, the
overlay automatically prints with your document.

7. Click OK or Print until you exit the Print window.

The selected overlay prints over your document.

>

w The resolution of the overlay document must match the resolution
of the original print job.

Deleting a overlay

You can delete page overlays that you no longer use.

In the Printing Preferences window, click the Advanced tab.
Select Edit... in the Overlay drop-down list.

Select the overlay you want to delete from the Overlay List box.
Click Delete.

When the confirming message window appears, click Yes.

Click OK or Print until you exit the Print window.

oAM=

containing your content. Graphics tab options

1. Create or open a document containing the content you want to use in
a new page overlay. Position the items exactly where you want them
to appear when they are added to the original.

2. To save the document as an overlay, access Printing Preferences [»ﬂ :

(See "Opening printing preferences" on page 57).

3. Click the Advanced tab, and select Edit... from the Text drop-down
list. The Edit Overlay window appears.

4. In the Edit Overlay window, click Create.

5. In the Save As window, type a name of up to eight characters in the
File name box. Select the destination path, if necessary. (The
default is C:\FormOver.)

6. Click Save. The name appears on the Overlay List.

7. Click OK or Print until you exit the Print window.
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Use the following Graphics options to adjust the print quality for your
specific printing needs.

The options you can select may vary depending on your printer
model.

« If the option is grayed out or not shown, that option is not
applicable with the printer language you are using.

To change the printer language:
1. Click the Windows Start menu.
2. For Windows 2000, select Settings > Printers.
- For Windows XP/Server 2003, select Printer and Faxes.

- For Windows Server 2008/Vista, select Control Panel >
Hardware and Sound > Printers.

- For Windows 7, select Control Panel > Hardware and



